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Abstract 

Like many watersheds in the North Cascades range of Washington State, USA, 

streamflow in the Nooksack River is strongly influenced by precipitation and snowmelt in 

the spring and glacial ice melt in the warmer summer months. With a maritime climate and 

high relief containing approximately 34 km
2
 of glacial ice, the streamflow response in the 

Nooksack River basin is sensitive to increases in temperature. Climate projections from 

global climate models (GCMs) for the 21
st
 Century indicate increases in temperature with 

variable changes to precipitation. The watershed is a valuable freshwater resource for 

regional municipalities, industry, and agriculture, and provides critical habitat for endangered 

salmon species. Thus, understanding the impacts of forecasted climate change is critical for 

water resources planning purposes. I apply publically available statistically derived 1/16 

degree gridded surface climate data along with the Distributed Hydrology Soil Vegetation 

Model (DHSVM) with newly developed coupled dynamic glacier model to simulate 

hydrologic and glacial processes through the end of the 21
st
 Century.  

Simulation results project median winter streamflows to more than double by 2075 

due to more precipitation falling as rain rather than snow, and median summer flows to 

decrease by more than half with a general shift in peak snowmelt derived spring flows 

toward earlier in the spring. Glaciers are projected to retreat significantly with smaller 

glaciers disappearing entirely. Ice melt contribution to streamflow is likely to play an 

important role in sustaining summer baseflows in the Nooksack River. Glacier melt derived 

streamflow is projected to increase throughout the first half of the 21st century and decrease 

in the latter half after glacier ice volume decreases substantially.  
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1.0 Introduction 

The Nooksack River drains an approximately 2000 km
2
 watershed in the North 

Cascade Mountains in Washington State, USA and serves as a valuable fresh-water resource 

for commercial, municipal, industrial, irrigation, and domestic uses as well as for fish habitat 

(Figure 1). The headwaters of the Nooksack River are in high elevation regions near the 

flanks of Mt. Baker that receive significant winter snowfall and contain a high concentration 

of glaciers (about 34 km
2
). Historically, streamflow in the Nooksack River basin has been 

regulated by fall and winter rainfall, and the timing of spring snowmelt and late summer 

glacier melt. Because of its importance as a resource, water managers and stakeholders have 

grown concerned over the effects that climate variability and change might have on the 

region’s snowpack and glacier recession and hence, the timing, magnitude, and quality of 

streamflow in the Nooksack River. 

The Nooksack River basin is a transient rain-snow basin due to the maritime climate 

of the Pacific Northwest (PNW), making it susceptible to impacts from climate change as 

snowpack is reduced with warming temperatures (Elsner et al., 2010; Mantua et al., 2010; 

Mauger et al., 2015). The upper sub-basins of the Nooksack River, and the focus of this 

study, include the North, Middle, and South forks. Each of the three sub-basins differs in 

relief and the amount of high versus low elevation area, which has a considerable effect on 

hydrology (Figure 2). In the North and Middle forks, much of the spring and early summer 

flows are supplied by snowmelt, whereas significant portions of late summer flows are 

supplied by glacier melt (Bach, 2002; Dickerson-Lange and Mitchell, 2013; Grah and 

Beaulieu, 2013). The lower elevation South Fork basin, with no glaciated area, is snowmelt 
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and rain dominated. Nooksack River annual discharge averages approximately 110 cubic 

meters per second (cms) but can reach as high as 1600 cms during floods (USGS, 2013). 

Streamflow typically falls below 30 cms in the late summer months as the snowpack and 

precipitation inputs diminish. During these warm late summer months, the contribution of 

glacier ice melt becomes increasingly important. 

Topographic relief in the Nooksack basin rises from sea level to over 3000 m in the 

Cascade foothills and mountains (peak elevation 3286 m at Mount Baker), which has a large 

influence on weather patterns and precipitation distributions due to orographic effects 

(Dickerson-Lange and Mitchell, 2013). Additionally, the annual variability in temperature 

and precipitation is strongly influenced by climate events such as the Pacific Decadal 

Oscillation and El Nino Southern Oscillations, making the PNW a complex and unique 

meteorological system (Mantua and Hare, 2002; Deser et al., 2012). Observed mean annual 

PNW temperatures have increased 0.6-0.8C since the early 20
th

 Century (Abatzoglou et al., 

2014). Precipitation for the same time period has also increased overall, but the trends are 

small when compared to natural variability (Mote et al., 2014). However, assessing local 

historic changes specific to the Nooksack River basin is difficult because meteorological 

coverage is sparse, with the nearest long-term weather station located outside of the basin in 

Clearbrook, WA (Figure 1). 

Climate projections for the PNW suggest increased annual temperatures and seasonal 

changes in precipitation with an increase during the winter months and a decrease during the 

summer months (Elsner, et al., 2010; Hamlet et al., 2010a; Mote and Salathe Jr, 2010; Vano 

et al., 2010; Abatzoglou et al., 2014; Tohver et al., 2014). Average annual temperatures are 

forecast to increase 3.3-9.7C by 2070 to 2099 compared to the period 1970-1999 (Mote et 
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al., 2014). Previous Nooksack River basin modeling has predicted a decrease in mean 

monthly snow water equivalent (SWE) of 33% to 45% at higher elevations, an increase in 

winter streamflows of 34% to 60%, and a projected decrease in summer streamflow of 22% 

to 35% by 2050 (Dickerson-Lange and Mitchell, 2013). These findings are consistent with 

other studies throughout the PNW (e.g., Mote et al., 2005; Vano et al., 2010; Hamlet et al., 

2013; Tohver et al., 2014) and suggest that the region could experience the decline and 

eventual disappearance of a springtime snowmelt peak. 

With 12 significant glaciers, Mount Baker has one of the largest networks of glaciers 

in the North Cascades (Pelto and Brown, 2012). Glacier mass balance studies in the 

Nooksack River Basin and throughout the PNW have shown significant historical retreat of 

glaciers and retreat is expected to continue as the climate warms (Fountain et al., 1997; 

Bidlake et al., 2002; Palmer, 2007; Moore et al., 2009; Riedel and Larrabee, 2011; Pelto and 

Brown, 2012; Stocker et al., 2013). With potentially less snowpack and warmer 

temperatures, continued glacial recession will likely have adverse long-term effects on the 

late summer stream flows in the Nooksack River (Donnell, 2007; Grah and Beaulieu, 2013). 

 In this study, I use the Distributed Hydrology Soil Vegetation Model (DHSVM; 

Wigmosta et al., 1994) along with a newly coupled dynamic glacier model (Clarke et al., 

2015) to assess the impacts of climate change and glacier recession on streamflow within the 

Nooksack River Basin. I emphasize late summer months, when precipitation inputs are 

minimal and glacier melt is a significant contributor to streamflow. The DHSVM allows for a 

high resolution physically based representation of the watershed and takes into account 

spatial heterogeneity. This grid based distributed hydrology model has been used extensively 

in the PNW (e.g., Alila and Beckers, 2001; Donnell, 2007; Cuo et al., 2009; Dickerson-
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Lange and Mitchell, 2013). The glacier dynamics component of the model simulates glacier 

flow, melt, and ice volume changes and incorporates them into watershed processes by using 

mass and energy fluxes between the atmosphere and land surface estimated by the DHSVM 

at each model cell (Figure 3; Naz et al., 2014; Clarke et al., 2015). In earlier work, ice was 

treated as static and melted in situ; whereas the dynamic glacier model expands our 

understanding of glacier contributions to watershed hydrology by simulating changes in 

glacier area and ice flow downhill using topographic gradients (Figure 2).  

Because of the lack of historical weather stations in the Nooksack River basin, I 

employ a publically available statistically extrapolated historical meteorological 1/16 degree 

grid (Livneh et al., 2013, 2015) to calibrate the model along with observed streamflow, 

snow-water equivalents, and observed glacier areal extents.  I project future Nooksack basin 

processes with the calibrated DHSVM forced with publically available 1/16 degree 

statistically downscaled future climate datasets from global climate models (GCMs) of the 

Coupled Model Intercomparison Project Phase 5 (CMIP5) that have been downscaled by the 

Multivariate Adapted Constructed Analogs method (MACA; Abatzoglou and Brown, 2012) 

using the Livneh historical grid as a training dataset. The gridded meteorological inputs allow 

control over the local variation and weather patterns in the Nooksack River basin and more 

efficient downscaling processing, which typically is cumbersome and time-consuming when 

downscaling to watershed-scale resolution (e.g., Hamlet et al., 2010b). I simulate snowpack, 

glacial recession, and streamflow evolution for the North, Middle, and South forks of the 

Nooksack River basin from 1950 to 2099 and project future trends at 30-year climate 

intervals surrounding the years 2025, 2050, and 2075. 
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2.0 Methods 

2.1 Model Setup 

 The DHSVM is a physically based, spatially distributed hydrology model that 

requires explicit physical characteristics of the watershed, including topography, land cover, 

soil type, soil thickness, and a streamflow network. The digital inputs were acquired from 

publically available sources (e.g., USGS, NLCD, STATSGO, and GLIMS) and processed in 

ArcGIS into 50 m grids (Appendix A). Separate watershed boundaries and digital datasets 

were created for each sub-basin (North, Middle, and South forks of the Nooksack River 

basin) to better capture the local variability. 

Meteorological inputs for the DHSVM include temperature (°C), relative humidity 

(%), precipitation (m), wind speed (m/s), and incoming shortwave and longwave radiation 

(W/m
2
). Because of the lack of consistent historical meteorological observations in the 

Nooksack River basin, I chose to force the model during calibration with a publically 

available statistically derived meteorological grid (Livneh et al., 2013, 2015). The Livneh 

grid utilizes precipitation and minimum and maximum temperature data collected from 1915-

2011 throughout the contiguous United States from approximately 20,000 National Climate 

Data Center (NCDC) cooperative observer weather stations and statistically interpolates 

those data to form a continuous 1/16 degree (~ 6 km) resolution grid. Monthly precipitation 

estimates from the Parameter-Elevation Regressions on Independent Slopes Model (PRISM; 

Daly et al., 1994) are incorporated into the Livneh grid to further account for spatial 

variability. Only stations with a minimum of 20 years of valid data are used in the 

interpolation. Center points of each Livneh grid cell were used as meteorological input 
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locations for the DHSVM (Figure 4). The daily Livneh meteorological gridded time series 

were disaggregated into 3-hour timesteps using the variable infiltration capacity model (VIC; 

Liang et al., 1994) which employs the MTCLIM scheme for downscaling meteorological 

forcings (Bohn et al., 2013) to better capture sub-daily fluctuations in radiation inputs. 

The DHSVM has flexibility in how the user defines lapse rates for both temperature 

and precipitation. Rather than using a single temperature lapse rate for the entire basin, I 

adjusted the lapse rate on a monthly basis. To better capture the influence of complex 

topographic variability on precipitation, the DHSVM was set up to calculate precipitation 

lapse rates based on elevation and the magnitudes of precipitation represented by monthly 

PRISM 30-year precipitation normal grids (1981-2010; PRISM Climate Group, 2014). The 

manipulation of these precipitation and temperature lapse rates throughout the basin served 

as additional calibration techniques to improve the model’s accuracy. 

2.2 Calibration and Validation 

2.2.1 Streamflow and Snow Water Equivalent (SWE) Calibration 

Calibration and validation of the model included the comparison of modeled 

streamflow output to historic streamflow observations from USGS gauging stations on the 

North Fork (12205000), Middle Fork (12208000), South Fork (12209000), and one on the 

main stem below the confluence of three forks at North Cedarville (12210700; Figure 1). The 

USGS stream gauge in the Middle Fork is below the City of Bellingham’s diversion dam, 

which periodically diverts water from the Middle Fork to Lake Whatcom via a pipeline 

(Tracy, 2001). Daily volume estimates of the diverted water (personal communication, Joanie 

Greenberg) were added to the observed USGS discharge for the calibration period. Modeled 
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SWE was compared to observed SWE at the Wells Creek (1228 m elevation), Middle Fork 

Nooksack (1515 m elevation), and Elbow Lake (927 m elevation) NRCS SNOTEL sites in 

the North, Middle, and South fork basins, respectively (Figure 1). However, since the 

SNOTEL site measurements only capture meteorology in one small location and are not 

representative of the entire watershed, SWE measurements were used only as a guide and not 

as a primary calibration element. As such, I examine SWE results as a basin-wide average. 

Statistical techniques such as the Nash-Sutcliffe model efficiency coefficient (NSE: Nash and 

Sutcliffe, 1970) as well as graphical comparisons were used to assess the goodness of fit 

between the simulated output and the historical observations. When possible, 10-year 

calibration/validation periods were used to ensure that the model was properly reproducing 

basin characteristics and its responses to typical meteorological changes, eliminating bias 

toward anomalous water years. North and Middle fork streamflow was calibrated for water 

years 2001-2005 and validated for 2006-2010 while South Fork flows were calibrated for 

water years 1999-2003 and validated for 2004-2008 due to a change in gauging location after 

water year 2008. Streamflow at the North Cedarville gauge was simulated by adding of the 

North, Middle, and South fork flow outputs and was calibrated for the water years 2006-2010 

(water year 2006 was the first year of consistent record for this gauge). If calibration or 

validation results from the model were not accurately reproducing the observed data, 

sensitive parameters that reflected basin characteristics were modified. These sensitive 

parameters included but were not limited to temperature and precipitation lapse rates, snow 

and rain temperature thresholds, and soil porosity and lateral conductivity, consistent with 

other studies of DHSVM parameter sensitivity (Du et al., 2013; Kelleher et al., 2015).  
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2.2.2 Dynamic Glacier Model Setup and Calibration 

The dynamic glacier model requires four main input parameters: 1) glacier domain or 

the areal extent of ice coverage (including the extent of contiguous ice bodies on both sides 

of the watershed boundary), 2) bed topography beneath the ice, 3), basin-wide annual mass 

balance, and 4) ice surface topography (Naz et al., 2014; Appendix B). Domain mask area 

includes non-glaciated basin area in order to allow for glacier area changes and flow outside 

of the historically observed ice extent if needed. Glaciers that are adjacent to the basin and 

glaciers that are at least partially inside of the basin are included, meaning that in some 

regions the glacier domain extends beyond the area of the watershed mask. This is important 

as watershed boundaries do not always correspond exactly to glacier flowshed boundaries. 

Historic observed glacier coverage was obtained through Landsat imagery, GIS land cover 

layers, and historical USGS topographic maps.  

The DEM was assumed to be an adequate representation of basal topography and was 

thus used as the bed topography elevation input to the dynamic glacier model. Other more 

complex methods for estimating bed topography have been used in previous studies and 

require multiple inputs such as thinning rates and distributed mass balances (e.g., Clarke et 

al., 2013). However, for areas with relatively thin ice coverage (less than 300 m), the effects 

of using a more complex bed topography compared to using a DEM are minimal, yielding 

only slight differences in glacier volume and no difference in glacier area (Naz et al., 2014). 

The glacier model produces a basin-wide ice mass balance grid which shows the net 

accumulation or ablation for each 50 m cell, including for non-glaciated areas, for the 

simulation period (10 years for glacier calibration purposes). A calibrated mass balance field 

is needed to estimate ice thickness and produce the surface topography field. To calibrate the 
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mass balance, the glacier model was run under a static mode (i.e., no simulated glacier flow) 

with a simulated 1000 m thick ice layer over the entire basin. The static and uniform 1000 m 

ice layer allowed for the estimation of ice change magnitudes for each grid cell throughout 

the entire basin, thus producing a continuous mass balance grid. A 1000 year spinup period 

using the mass balance grid was then run to achieve glacier equilibrium conditions. The 

result of the spinup run was an estimated ice coverage and ice thickness layer based on the 

mass balance from the static run. If ice coverage did not adequately match historical ice 

extent observations, model parameters such as temperature lapse rates or snow/rain 

temperature thresholds were adjusted and the mass balance was recreated using the static 

model once more, and a new spinup simulation was run. Model parameters were iteratively 

adjusted until a mass balance that produced reasonable 1950s-scale ice coverage was created. 

The ice layer was then added to the basin DEM to produce the ice surface topography input 

needed for the dynamic glacier model. 

In this initial application of the coupled hydrology-glacier model in the Nooksack 

River basin, I calibrated the glacier model based primarily on historical ice extents from 1950 

(Raup et al., 2007) and 2009. A 20-year annual mass balance record from the Sholes Glacier 

in the North Fork basin was compared to modeled mass balance outputs from the Sholes. 

However, given the short period of observational record and the relatively long model runs, 

as well as the large spatial distribution of glaciers within the basin, the Sholes mass balance 

was not used as a primary calibration parameter but was used simply to ensure reasonably 

realistic mass balance results during calibration runs. 

Once the glacier inputs had been produced, the DHSVM-glacier model was run and 

ice changes were incorporated into the watershed hydrology processes. The coupled model 
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was run for a 60-yr calibration period from 1950-2010 and simulated glacier changes were 

compared to observed areal changes. Because of the coupled nature of the model, streamflow 

and SWE calibration was carried out in concert with glacier calibration. To obtain historic 

glacier melt contribution to streamflow, the DHSVM was run twice from 1950-2010; once 

under dynamic glacier conditions and once with all glaciation turned off (i.e., all ice was 

removed from the basin). The difference in the resulting streamflow between the two runs 

was then assumed to be the glacier melt contribution to streamflow. With glaciation turned 

off, the DHSVM assumes that there is no permanent ice anywhere within the watershed. 

Glaciated areas are replaced by soil type found in the soil coverage input file for that area 

(usually bedrock for higher elevation areas) and all other parameters remain the same as in 

the dynamic model run. 

2.3 Future Hydrologic Modeling Simulations and Predictions 

To capture the variability in possible future climate scenarios, I used the MACA 

downscaled results from 10 GCMs under two Representative Concentration Pathway (RCP) 

scenarios (RCP4.5 and RCP8.5; Table 1). Rupp et al. (2013) determined that these 10 GCMs 

in particular are most suitable for climate prediction in the PNW. The 10 MACA downscaled 

GCMs indicate an annual temperature increase by 2075 ranging from approximately 2 to 3.4 

degrees C for the RCP 4.5 scenario and 2.9 to 4.7 degrees C for the RCP 8.5 scenario in the 

upper Nooksack Basin (Table 2). MACA climate data are downscaled using the Livneh et al. 

(2013) observational data as the training dataset (Appendix C). As such, the same Livneh 

grid point locations (Figure 4) serve as MACA climate forcings locations and the same lapse 

rates and elevation corrections used in the calibration process for the Livneh grids are applied 
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to the MACA data. Using the Livneh and MACA datasets ensures that climate corrections to 

historical periods can be applied to maintain consistency in future prediction. 

I simulate hydrology and glacier dynamics in the Nooksack River basin with the 

calibrated DHSVM model for water years 2010-2099 using 20 MACA climate scenarios as 

meteorological inputs. For the glaciated Middle and North Fork basins, simulations were 

performed with and without glaciers for each MACA scenario to estimate the ice melt 

contribution to streamflow.  To project long term trends in hydrologic processes within the 

basin, I examine 30-year median flows (including glacier melt) and median SWE centered on 

2025, 2050, and 2075. Additionally, ice coverage maps were produced at 10-year intervals in 

order to track glacier changes through time. 

3.0 Results 

3.1 Model Calibration 

Because of biases to input data, simultaneous calibration of the DHSVM to 

streamflow, SWE, and glacier extent proved unrealistic without additional tuning and bias 

corrections. I started the calibration process by correcting the statistically derived, historical 

Livneh data for observed biases. A cold bias was noted in the Livneh grid when compared to 

modern PRISM normals (1981-2010). The Livneh grid implemented in this study was 

developed using a constant temperature lapse rate of minus 6.5 degrees C per km (Livneh et 

al., 2013). At high elevations in particular, the maximum and minimum monthly Livneh 

temperatures were significantly lower than those from the PRISM climatology. The cold bias 

was also apparent when comparing Livneh monthly median temperatures to those at the 

SNOTEL sites within the appropriate Livneh cells in the upper Nooksack River basin (Figure 
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5). A delta method correction (e.g., Sperna Weiland et al., 2010; Watanabe et al., 2012) was 

applied to all Livneh cells within each of the three sub-basins to adjust to the PRISM 

temperature normals (Chris Frans, personal communication). After the correction, a 

comparison with SNOTEL observational temperature data from each of the three sub-basins 

indicated a more realistic representation of monthly temperatures (Figure 5).  

A precipitation bias was also identified in the Linveh data; in some locations, lower 

elevation cells showed a considerably higher precipitation than those at higher elevations. A 

correction was applied where necessary by incorporating a monthly precipitation correction 

factor derived using observed precipitation and elevation relationships between the nearby 

Abbotsford weather station and the basin SNOTEL sites (Figure 1). The precipitation lapse 

rate between the stations was used to produce a monthly correction scaling factor to adjust 

Livneh precipitation magnitudes in the South Fork and North Fork basins. In the Middle Fork 

basin, precipitation correction was not required and uncorrected Livneh data was used for 

precipitation inputs. 

The bias corrections markedly improved the calibration of the model. Additional 

calibration required the adjustment of the DHSVM parameters, specifically the rain/snow 

threshold temperatures and the temperature-lapse rate values. Each of the three basins was 

unique and required different parameter magnitudes and modifications to balance the 

observed streamflow, SWE, and glacier coverage. The glaciated Middle and North fork 

basins were more problematic because the glacier coverage was more sensitive to 

temperature lapse rates than hydrology was. Thus, final calibration required the use of 

different temperature lapse rates in each basin (Table 3). Peak flows and baseflows were 
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moderately influenced by soil properties such as thickness, porosity, and lateral hydraulic 

conductivity. Such model parameters were altered as needed and differed by basin (Table 4). 

3.1.1 Snow Water Equivalent 

 Calibrating SWE to specific SNOTEL observations had mixed results, partly because 

a SNOTEL site represents a single grid cell in the DHSVM and may not reflect basin-wide 

snow hydrology. SNOTEL sites have also been shown to produce biased temperature 

readings in some locations, potentially affecting calibration accuracy (e.g., Oyler et al., 

2015). The model reasonably predicted the SWE at the Wells Creek SNOTEL site in the 

North Fork basin, with most water years matching closely to the observed dataset (Figure 6). 

The model under-simulated SWE during most years at the SNOTEL sites in the Middle Fork 

and South Fork basins (Figure 6). While annual magnitudes of SWE were not replicated 

satisfactorily in the model runs, the temporal distribution of SWE matched the data closely 

for most water years. Note, however, that the model’s success in predicting streamflow, 

particularly spring and early summer flows, in part validates its ability to capture basin-wide 

snow accumulation and melt. In the results and discussion, I present SWE changes as a 

basin-wide average.  

3.1.2 Historic Glacier Extent 

Initial ice extent (1950) compared well to historical estimates of glacier coverage in 

both the Middle and North fork basins, with a 14% over-estimation of total modeled ice 

extent for the North and Middle forks combined (Figures 7 and 8; Table 5). In the Middle 

Fork, comparisons between observed 2009 ice extent and simulated ice extent after a 

simulation period from 1950 to 2009 show that the model is producing reasonable ice extent 
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changes through time, comparable to observed estimates (Figure 7). Simulated 2009 ice 

extent was greater than the estimated observed extent and contained thin ice coverage in the 

steep cliff bands of the mountains. The excess thin ice is attributed at least in part to the lack 

of an avalanching component in the model and the thin ice was left in place to maintain the 

hydrologic mass balance of the basin.  

The North Fork basin, with far more glaciated area than the Middle Fork, had more 

error associated with both the initial 1950 and 2009 ice coverages (Figure 8). Initial 1950s ice 

coverage in the higher relief regions of Mount Baker was difficult to reproduce and the final 

spinup results over-estimated ice extent in the lower tongues of the Roosevelt and Mazama 

glaciers. During model runs from 1950-2009, over-simulation of ice in the lower reaches of 

these glacier valleys occurred as well, resulting in too large of a glaciated area. This problem 

was not able to be corrected without negatively impacting the ice extent in adjacent glaciated 

areas and was the most pronounced on Mount Baker. Modeled annual mass balance from the 

Sholes glacier on Mount Baker did, however, compare well with the 20-year observational 

record (Figure 9; Pelto and Brown, 2012). Glacier area changes on Mount Shuksan more 

closely matched observational ice coverage changes through 2009. Like in the Middle Fork 

basin, small patches of excess thin ice were simulated in places where no glaciers exist. The 

2009 ice extent error was approximately 46% for the North and Middle fork basins combined 

(Table 5). While the area was over-estimated during historical runs, the majority of modeled 

ice volume still remained within the target observed extent (Table 5) indicating that the 

majority of modeled ice was still being simulated where it should be. 
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3.1.3 Streamflow Calibration 

Calibrated streamflow compared well to all four USGS stream gauges within the 

upper Nooksack basin. Daily late summer flows were captured well but peak storm flows 

throughout each water year were generally under-simulated in each of the three basins 

(Figure 10). Calibration of monthly peak flows varied and the model over-simulated peak 

magnitudes during some water years and under-simulated during others (Figure 11). The 

modeled streamflow had Nash-Sutcliffe efficiency scores of greater than 0.5 for daily flows 

and greater than 0.7 for monthly flows for 10-year calibration/validation periods at their 

respective USGS gauges (Table 6). Cumulative streamflow calibration success also differed 

between basins and was heavily influenced by large individual storm events. The model 

under-simulated cumulative stream discharge by less than 6% at the Middle Fork USGS 

gauge location and less than 5% in the North Fork basin but over-simulated cumulative 

stream discharge by less than 4% for the South Fork basin at the end of their respective 10-yr 

calibration/validation periods (Figure 12 and Table 6). Mean monthly stream discharge error 

was less than 4% for the North Fork, less than 5% for the Middle Fork, and less than 2% for 

the South Fork (Table 6). 

At the North Cedarville gauge where flows from the three sub-basins are combined, 

daily and monthly streamflows were simulated with Nash-Sutcliffe efficiency scores of 0.53 

and 0.71, respectively (Figures 10 and 11 and Table 6). Peak flows were generally under-

simulated while baseflows and recession curves matched well, with the exception of water 

year 2009 when simulated January and February baseflows were too low. A positive 

cumulative stream discharge error at the gauge location of 3.6% at the end of the calibration 

period was obtained, indicating an over-simulation of streamflow volume after the 5-year 
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period (Figure 12). Mean monthly stream discharge error was less than 5% at the North 

Cedarville gauge location (Table 6). 

3.2 Historic Glacier Melt 

 Modeled historic glacier melt volumes for the North and Middle fork basins 

appreciably support streamflow in the late summer months, particularly August and 

September. The timing of the glacier melt season differs by basin, extending from early May 

through the end of October for the North Fork and from mid-June through the end of October 

for the Middle Fork. During many water years, daily late summer glacier melt contribution to 

streamflow regularly exceeds 1.5 cms in the Middle Fork and 5 cms in the North Fork 

(Figure 13). Modeled median monthly historical glacier melt reaches approximately 15% of 

total streamflow for both the North and Middle Fork basins and just above 10% at the North 

Cedarville location during August and September, although there is large variation 

throughout the historical simulation period (Figure 13). Monthly median glacier melts can 

make up as much as 50% of total flows in the Middle Fork and 40% in the North Fork basins. 

Third quartile melts are approximately 30% of total flow in the Middle Fork and 25% of total 

flow in the North Fork for the late summer months. It should be noted however, that because 

peak glacier melt contribution to streamflow occurs at the end of August and beginning of 

September, monthly averages may dampen the analysis of the total melt flows on daily and 

weekly timescales. 
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3.3 Hydrologic Modeling throughout the 21
st
 Century 

3.3.1 Snow Water Equivalent 

Model results for all three sub-basins forecast a significant basin-wide snowpack 

SWE decrease in both the RCP 4.5 and 8.5 forcing scenarios as warming occurs (Figure 14). 

Through 2050, both RCP scenarios show similar SWE magnitudes but toward the second 

half of the century the RCP 8.5 scenarios result in a significantly lower daily basin-wide 

average SWE than the RCP 4.5 scenarios. By 2075, Middle Fork ensemble median SWE 

magnitudes peak at approximately 0.4 m and 0.25 m for RCP 4.5 and 8.5 respectively, 

significantly lower than the historical modeled median (1950-2010) of approximately 0.8 m. 

South Fork ensemble median SWE magnitudes at 2075 peak at approximately 0.15 m and 

just over 0.05 m for RCP 4.5 and 8.5 respectively, also a significant decrease compared to the 

historical modeled median (1950-2010) of just over 0.4 m. In the North Fork basin, a 

decrease is projected from the historical modeled peak magnitude of approximately 0.75 m to 

just under 0.4 m and just over 0.2 m for RCP 4.5 and 8.5 respectively. 

In addition to SWE magnitude changes, deviations from the historic timing of 

snowpack presence and SWE peaks are expected throughout the 21
st
 Century in parts of the 

Nooksack River basin (Figure 14). The timing of peak SWE in the South Fork basin is 

forecasted to change under both RCP ensembles by the year 2075, when peak magnitudes are 

expected to shift to the month of February rather than March. The development of a 

snowpack in the South Fork basin is projected to occur later in the fall and disappear earlier 

in the spring, leaving the basin snow-free for longer time periods. In the North and Middle 

Fork basins, however, average elevation is higher and the timing of peak SWE is not 

expected to change as much. Even under the most aggressive scenarios, some snowpack is 
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expected to remain in the Middle Fork basin throughout the whole of a normal water year in 

2075. 

3.3.2 Glacier Recession and Ice-melt Derived Streamflow 

Under all future scenarios, large glaciers are modeled to decrease significantly in 

areal extent and ice thickness while smaller glaciers are likely to disappear completely. 

Glacier area changes throughout the 21
st
 Century are forecasted to be similar in magnitude 

and timing under both RCP scenarios until the latter half of the century when the two 

scenarios begin to diverge from one another (Figure 15). Glacier area is forecast to decline 

steadily under RCP 8.5 throughout the century but the rate of decline lessens near the year 

2050 for the RCP 4.5 ensemble. Additionally, a greater variation exists among GCMs under 

the RCP 4.5 scenario for both the Middle and North Fork basins. Modeled Middle Fork 

median ensemble ice extent for RCP 8.5 indicates a decrease 87% in the Middle Fork basin 

by the end of the century. RCP 4.5 is less severe but modeling still forecasts a significant 

decrease in area of approximately 69% (Figure 15). North Fork median ensemble ice extent 

is modeled to decrease by approximately 66% and 88% for RCP 4.5 and 8.5 respectively by 

2099 (Figure 15). 

 An increase in temperatures throughout the Nooksack basin is expected to alter the 

amount of glacier melt that is available to the stream (Figure 16). In both the North and 

Middle Fork basins, modeled glacier melt contribution to streamflow in the late summer 

months is estimated to be at a maximum during the first half of the 21
st
 Century when the 

largest surface area of ice is available for melt. During this time, median future ensemble ice 

melt exceeds modeled historical melt magnitudes under both RCP 4.5 and 8.5 scenarios. At 

the year 2025, modeled median peak ice melt for late summer months increases from 
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modeled historical levels by up to 51% for the North Fork and 87% for the Middle Fork 

(Table 7). The percentage of total streamflow that is derived from glacier melt is projected to 

approximately double for the Middle Fork and triple for the North Fork during this same time 

(Table 8). By 2050, peak glacier ice melt is forecast to be less than at 2025 with peak median 

magnitudes between 15-37% higher than historical levels for the Middle Fork and between 

14-20% lower for the North Fork. By 2075, ice melt is projected to be at approximately half 

of historical levels throughout both basins and at the North Cedarville gauge with little 

difference between RCP 4.5 and 8.5. The percentage of total streamflow derived from ice 

melt is projected to decrease to levels similar to 1950-2010 by the second half of the century. 

Timing of peak glacier ice melt is not forecast to change. A change in the timing of the onset 

of annual glacier melt is projected, however, with little to no estimated ice melt contribution 

to streamflow during the months of May or June by 2075 throughout the Nooksack River 

basin. The glacier melt estimates, particularly for the early decades of the 21
st
 Century are 

subject to error because the 2009 glacier ice extent was overestimated during historical 

model runs. Thus, glacier ice melt contribution to streamflow for the early decades of the 

future simulations is likely to be lower than the modeling projects. 

3.3.3. Streamflow 

Modeled results using 10 GCMs and RCP.45 and RCP 8.5 forcing scenarios within 

each of the three Nooksack sub-basins indicate similar trends throughout the 21
st
 Century 

with a general decrease in spring and summer flows and an increase in winter flows. Spring 

peak flows are predicted to occur earlier in the water year by as much as two months in parts 

of the upper Nooksack River basin, although peak spring melt varies by location in both 

magnitude and timing. 
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 Middle Fork Nooksack River modeling results through the end of the 21
st
 Century 

indicate a decrease in median daily spring streamflow magnitudes, although the timing of this 

peak remains unchanged (Figure 17). An increase in winter flows and a decrease in 

summertime flows are projected throughout the 21
st
 Century and become more significant 

toward the end of the century for both the RCP 4.5 and 8.5 scenarios. The RCP scenarios 

deviate little from one another until the latter half of the century when winter and summer 

flow changes between the two become more pronounced. The largest changes are projected 

to occur within the months of January, July, and August with a forecasted increase from 

historical winter flows by as much as 93% and 127% for RCP 4.5 and 8.5 scenarios 

respectively by 2075 (Table 9). Middle Fork summer flows are modeled to decrease by as 

much as 52% and 65% for RCP 4.5 and 8.5 respectively by 2075. 

 South Fork Nooksack River modeling results through the end of the 21
st
 Century 

indicate a decrease in median peak spring snowmelt derived streamflow magnitudes as well 

as a shift in the timing of spring snowmelt runoff to earlier in the water year by as much as 

two months (Figure 17). Like in the Middle Fork, an increase in winter flows and a decrease 

in summertime flows are projected throughout the 21
st
 Century and become more significant 

toward the end of the century for both the RCP 4.5 and 8.5 scenarios. South Fork summer 

flows by 2025 are projected to decline by a greater percentage than in the North and Middle 

Fork basins. By 2075, the largest changes are projected to occur within the months of 

January and July with a forecasted increase in winter flows by as much as 82% and 112% for 

RCP 4.5 and 8.5 scenarios (Table 9). Summer flows by the year 2075 are projected to 

decrease by as much as 65% and 76% for RCP scenarios 4.5 and 8.5, respectively. 
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 Future model projections indicate more substantial changes in the North Fork 

Nooksack River basin than in the Middle or South Fork basins as much of the area transitions 

from snow dominated to rain dominated. While winter flows are expected to increase and 

summer flows are expected to decrease, like in the other basins, the magnitude of change is 

higher by the latter half of the century (Figure 17). Median January forecasts indicate 

streamflow increases by as much as a 161% and 253% for RCP 4.5 and 8.5 respectively 

(Table 9). Summer median flow decreases for the month of July are projected to be -62% and 

-77% for RCP 4.5 and 8.5 respectively. Like in the Middle and South Fork basins, the two 

RCP scenarios are similar until 2075 when they begin to diverge. 

 Modeled streamflow projections at the North Cedarville gauge location, which 

encompass the flows from each of the three sub-basins, indicate similar trends with a 

decrease in winter flows and an increase in summer flows and little difference between RCP 

scenarios until 2075 (Figure 18). Snowmelt derived flows, which historically peaked during 

the months of May and June, show little to no shift in timing for RCP 4.5 by 2075 but a slight 

shift earlier in the season for RCP 8.5 by 2075. Modeling indicates an increase in median 

daily streamflow for the month of January by as much as 85% and 119% for RCP 4.5 and 8.5 

respectively (Table 9). Summer median flows are projected to decrease the most in July by 

59% and 72% for RCP 4.5 and 8.5. 

Peak discharge events, such as those from winter storms, are forecasted with lower 

confidence than median streamflows and baseflows. Observed historical streamflows above 

certain thresholds are difficult to capture through instrumentation and are predicted based 

solely on a rating curve and gauge height. Moreover, because modeled daily rainfall 

magnitudes are disaggregated into 3-hour time steps, high intensity storms responsible for 
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peaks are dampened. Because of these factors that lead to uncertainty in peak flow 

magnitudes, calibration of the DHSVM focused on the timing of storm events rather than 

achieving the exact magnitude. Forecasted high flow events should therefore be treated with 

caution and used only as a guide of trend. 

4.0 Discussion 

Changes in temperature and precipitation in recent decades have affected glaciers on 

a global scale and throughout western North America, leading to a general decline in total 

glacier area (Moore and Demuth, 2001; Lemke et al., 2007; Moore et al., 2009; Bolch et al., 

2010; Pelto and Brown, 2012; Gardner et al., 2013; Hartmann et al., 2013; Clarke et al., 

2015). Long term field monitoring within the North Cascades has shown a significant 

decrease in the net mass balance of all benchmark glaciers studied (Bidlake et al., 2010; 

Riedel and Larrabee, 2011). Included among these is the South Cascade Glacier which has 

been monitored since 1958 and showed a net decrease in area from 2.71 km
2
 to 

approximately 1.73 km
2
 by 2007 with continued retreat since then (Bidlake et al 2010). Other 

regional studies, however, have noted variable changes in North Cascades glacier area since 

the mid-1900s with periods of advance as well as periods of retreat (Pelto and Brown., 2012; 

O’Neal et al., 2015). Pelto and Hedlund (2001) found that nearly half of the glaciers within 

the North Cascades advanced from the 1950s through the 1970s while others retreated. The 

relationship between large-scale climate events such as the PDO and ENSO have been noted 

in previous studies (Moore and Demuth, 2001; Josberger et al., 2007), suggesting that these 

interdecadal climate events have a regional effect on glacier size. In the application of the 

calibrated dynamic glacier model in the DHSVM, I found cycles of advance and retreat 
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within the Nooksack basin, including a rapid advance through the 1950s and another advance 

in the 1970s with a period of retreat in between. However, when compared to time series of 

the Pacific Decadal Oscillation and the El Nino Southern Oscillation, there is very little 

relationship between the timing of warm cycles (positive index) and modeled glacier retreat 

or cold cycles (negative index) and modeled glacier growth (Figure 19).  

Although the glacial model simulated historical advances and retreats, the final 

calibration of glacier extent, especially in the North Fork basin, did not match the observed 

extent in some locations because the model simulated ice in areas where there should be no 

ice (Figure 10 and Figure 11). Extra ice development was in part due to the limited control of 

the temperature and precipitation interpolations at high elevations in complex terrains, 

particularly on Mount Baker. This led to the simulation of thick ice tongues in the lower 

valleys flanking Mount Baker. Thin ice development was also noted in areas between 

glaciers and could be due in part to the lack of an avalanche simulator in the glacier 

dynamics model that would transport snow from steep cliff areas to the valleys and glaciers 

below. In reality, snow accumulates on steep cliff areas but generally avalanches to the valley 

floor before enough snow is able to accumulate and reach the density of ice (e.g., Elder et al., 

1991).  The thin ice layers were kept in the calibrated version in an effort to preserve the 

hydrologic mass balance within the watershed but likely were a contributing factor in the 

variability seen in modeled historical ice extent, particularly during early timesteps of the 

simulation period (i.e., the 1950s) when the thin ice layer initially formed. 

Like other glacier change modeling studies (Radić et al., 2013; Naz et al, 2014; 

Clarke et al., 2015), I relied on estimated historical ice extent for glacier spinup and 

calibrations and assumed that historical observations of areal ice extent were accurate and 
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were a representation of equilibrium conditions. I used glacier areal changes through time to 

assess the model’s effectiveness at simulating dynamic glacier processes. In reality, 

estimating ice coverage from datasets such as satellite imagery is difficult because ice-

bedrock boundaries cannot always be readily identified remotely. Other sources for observed 

glacier extent included digitized glacier outlines from 1:100,000 and 1:24,000 scale USGS 

topographic maps. Due to the small scale of these maps, there is error associated with the 

historical glacier locations and therefore is error in the initial and calibrated ice coverages 

used in the model.  

In all of the future modeling results, I find that projected median changes under RCP 

4.5 and 8.5 scenarios are similar to one another through the first half of the 21
st
 Century and 

then deviate beyond 2050. This pattern is due to the time lag response in the mitigation 

narratives imposed in the RCP 4.5 scenario in the GCMs (e.g., Hansen et al., 2005). Even 

with the decrease in anthropogenic greenhouse gas emissions proposed under the RCP 4.5 

scenario, atmospheric conditions do not stabilize and reach equilibrium until decades after 

mitigation measures are executed. Thus, the hydrological effects of emissions mitigation 

scenarios are likely to be felt more in the long-term rather than in the immediate future.  

Glaciers throughout the Nooksack River basin, based on DHSVM-glacier modeling, 

are forecasted to recede by nearly 90% throughout the 21
st
 Century with smaller glaciers 

disappearing entirely by 2100, even under RCP 4.5 climate scenarios (Figure 15). Stahl et al. 

(2008) found that even once temperatures and atmospheric conditions have become more 

stable, glaciers may still take decades to reach a new equilibrium and will continue to melt 

until that happens. Thus, even under future scenarios which incorporate emissions mitigation 

strategies and less aggressive warming such as RCP 4.5, glaciers are expected to show 
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significant retreat through the end of the century. In British Columbia, Canada, Clarke et al. 

(2015) projects similar trends in glacier retreat, with near total glacier loss in many places for 

the RCP 8.5 scenario by 2100 and little difference between RCP scenarios until after 2050. 

Similarly, Radić et al. (2013) model an average decrease in glacier area of greater than 75% 

in Western Canada and the United States under 14 CMIP5 GCMs and the RCP 4.5 scenario. 

My simulated changes in glacial recession through time are largely dependent on changes in 

ice thickness, which is difficult to properly estimate using modeling alone. I used a DEM to 

approximate ice thickness which has limitations, and without proper thickness, ice volume 

cannot be accurately established (Naz et al., 2014). However, since most historic areal extent 

changes through time matched observations, I assumed the estimated modeled ice thickness 

to be reasonable. 

With a potential reduction in glacier area and volume projected throughout the 21
st
 

Century under all future scenarios, the ice available (or lack therein) for melt will ultimately 

affect streamflow. I project median monthly glacier melt and its contribution to streamflow to 

be at its highest in the first half of the 21
st
 century when warmer temperatures and an earlier 

spring snowmelt will leave the glaciated areas exposed to atmospheric heat inputs for longer 

periods of time (Table 7). At 2025, modeling results indicate not only an increase in median 

ice melt magnitude but also an approximate doubling in the proportion of total streamflow 

derived from glacial melt for the Middle Fork, and a tripling for the North Fork during the 

summer months (Table 8). The larger increase in the streamflow melt component for the 

North Fork is likely due to the melting of excess ice that was over-simulated during historical 

model simulations. By 2075, the total magnitude of melt will be significantly lower than 

historical levels due to the reduction in glacial area. However, the proportion of total 
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streamflow derived from ice melt is projected to be similar to historical levels because of an 

overall reduction in streamflow due to less snowmelt and lower summer precipitation. 

Similar trends in glacier melt discharge magnitudes have been noted in other glacier change 

studies in Western North America (Nolin et al., 2010; Clarke et al., 2015). For the first part 

of the 21
st
 Century, glaciated basins such as the Middle Fork and North Fork will likely show 

less of a dramatic decrease in summer streamflows due to the increased rate of glacier melt, 

which partially compensates for the reduction in snowmelt. This is evident when comparing 

projected summer streamflow changes of the non-glaciated South Fork basin to the glaciated 

Middle and North Fork basins (Table 9).  

Modeling results project a significant decrease in basin average SWE in the Nooksack 

River basin as temperatures warm throughout the 21
st
 Century (Figures 14). These trends are 

consistent with Dickerson-Lange and Mitchell (2013) in the Nooksack River basin, and other 

regional modeling studies in the PNW (e.g., Hamlet et al., 2005; Mote et al., 2005; Mote et 

al., 2008; Adam et al., 2009). Our modeling results indicate a large decrease in median SWE 

magnitude as soon as 2025 for both RCP 4.5 and 8.5 scenarios, especially in the South Fork 

basin where peak elevations are lower (~ 2000 m) and only about 25% of the basin is above 

1000 m (Figure 2). The large decrease so early in the century is attributed to the transient 

nature of the low to mid elevation parts of the basin which are more sensitive to small 

changes in temperatures, and shift from being snow dominated to rain dominated (Elsner et 

al., 2010). Modeled SWE trends in the South Fork basin also show a much faster rate of 

decline through the end of the century and a shift in annual peak SWE to earlier in the season 

(Figure 14). The shift in the annual SWE peak is not as evident in the Middle and North Fork 



27 

 

basins, which have more northerly exposed aspects and higher percentages of areas with 

elevations between 1000 m and 3000 m (Figure 2). 

 The projected decrease in snowpack and changes in glacier melt magnitudes 

significantly affect the timing and magnitude of streamflow in the Nooksack River. My 

results reflect the general streamflow trends observed in other local and regional studies (e.g., 

Stahl et al., 2008; Vano et al., 2010; Dickerson-Lange and Mitchell, 2013; Hamlet et al., 

2013) which forecast a decrease in summer streamflows and an increase in winter flows 

when higher relief areas transition to being rain-dominated. Winter runoff will increase as the 

snow-line increases in elevation leaving more basin area snow-free and exposed to rainfall, 

thus increasing the flood risk during the wetter months (Tohver et al., 2014). While the 

overall amount of annual precipitation is not projected to change drastically from modern 

magnitudes in the PNW, warmer temperatures will reduce the basin-wide SWE available for 

spring and early summer snowmelt (Vano et al, 2010). I project spring peak runoff, which is 

primarily due to snowmelt, to occur earlier in the water year and to be substantially lower 

(Figure 17 and Figure 18) if temperatures are similar to those forecast in the more aggressive 

climate models. The hydrograph is likely to shift from a bimodal distribution to a more 

unimodal distribution, as is characteristic of rain-dominated systems (Figure 17 and 18). 

Other modeling studies in the PNW have projected similar changes in the timing of peak 

snowmelt runoff (Barnett et al., 2004; Vano et al., 2010; Dickerson-Lange and Mitchell, 

2013), which has the potential to greatly impact water resources in the drier summer months 

and threaten valuable stream habitat.  

The DHSVM-glacier model did well at reproducing hydrological processes in low- to 

mid-elevation areas which make up the majority of the basin (Figure 2), but was less 
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effective at higher elevations. This affected the results of glaciation, basin average snowpack 

SWE, and streamflow in areas of the Nooksack River basin at high elevation. The reasonable 

simulation of glacier mass balance on the Sholes glacier (Figure 12), which has its highest 

point at approximately 2100 m, shows the ability of the DHSVM-glacier model to simulate 

ice mass changes effectively where meteorology and snowpack evolution is reproduced 

realistically. At higher elevations, however, snowpack was found to be melting at too slow a 

rate or not at all during summer months which led to the production of too much ice on parts 

of Mount Baker. While some snowpack does exist on Mount Baker year-round, basin 

average SWE should realistically be lower during late summer months (Figure 14). The 

excess summer snow also accounts for the lack of change in seasonal timing of peak SWE 

for the North and Middle forks. If projections are compared to historical modeled magnitudes 

at the SNOTEL sites, a clear shift in peak SWE timing to earlier in the season can be seen 

(Figure 20). Additionally, this excess snowpack on Mount Baker is likely responsible for the 

lack of a shift in the spring snowmelt runoff peak for the Middle Fork and the minimal 

change seen in the North Fork. The Middle and North forks contain a larger proportion of 

total basin area at high elevation and are therefore more heavily influenced by the larger 

high-elevation summer snowpack. The complexities of the Mount Baker climate system with 

its high relief and maritime weather events made controlling and refining modeled 

temperature lapse rates at high elevations difficult. Attempts to alter lapse rates included 

manually changing monthly temperature lapse rates at individual high elevation Livneh grid 

cells nodes. However, the alteration of monthly temperature lapse rates from their final 

calibrated values led to poor model performance with respect to streamflow. 



29 

 

 As with all modeling studies, there are uncertainties.  I relied on statistically 

extrapolated daily meteorology grids (Livneh et al., 2013) to force the model during 

calibration. Although this method allowed for complete meteorological coverage of the study 

area, it required bias corrections and lapse rate adjustments, and was disaggregated in to 3-

hour timesteps in order to capture sub-daily snowpack and ice changes. Disaggregation 

introduces error which can be propagated through the modeling process (e.g., Margulius and 

Entekhabi, 2001). Disaggregation also takes daily precipitation data and averages it over 3-hr 

timesteps making streamflows during observed high intensity storm events difficult to 

replicate. Although this may be problematic when assessing storm effects, it is less of an 

issue when examining seasonal trends in snowpack evolution and long-term glacial dynamics 

and melt.  

Additional uncertainties come from the GCM climate forecasts since they make 

generalizations about many climate parameters and are at a coarse resolution relative to a 

2000 km
2
 watershed. The parameterization of finer scale processes undoubtedly introduces 

assumptions that do not hold true in the natural climate system and are not necessarily 

consistent between GCMs (Stainforth et al., 2007; Stocker et al., 2013). Recent studies have 

noted the variability among GCMs as a large source of uncertainty in the forecasting of 

glacial and hydrological changes (Barnett et al., 2005; Radić et al., 2013; Clarke et al., 2015). 

I found this to hold true and assumed ensemble medians to be the best representative 

projection of changes in hydrologic and glacial processes. Moreover, I used GMCs 

downscaled to the Nooksack basin using the MACA method, which is better at reproducing 

historical weather parameters than other commonly used downscaling techniques 

(Abatzoglou and Brown, 2012). However, because it relies on historical weather grids as the 
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training dataset, historical weather patterns and weather event regularity are assumed to 

remain consistent throughout the future. Bias behavior in the forcing data is also assumed to 

remain unchanged through time. Future work should focus on improving the spatial 

distribution of predictions of mountain glaciers in the Nooksack River basin by further 

refining lapse rates and other climate parameters. 

5.0 Conclusion 

Climate studies have revealed changes to Earth’s dynamic climate system and have 

projected changes and variability to continue into the foreseeable future. Changing climate 

conditions have the potential to alter dramatically the hydrology of much of the world with 

increasing temperatures, variable precipitation, reduced snowpacks, and glacial recession. 

Shifts in the hydrologic cycle will almost certainly affect water resources that are critical to 

individuals, communities, and natural habitats. In the PNW, where snowpack and glaciers are 

currently responsible for much of the summertime streamflow, understanding the potential 

effects of climate change is necessary. 

Through the use of the DHSVM and dynamic glacier model forced with downscaled 

gridded future GCMs, I quantified trends in basin snowpack, streamflow, glacier recession, 

and glacier melt contribution to streamflow in the Nooksack River basin throughout the 21
st
 

Century. A projected decrease in summer streamflows and an increase in winter flows as 

snowpack and glacier ice volume is decreased have the potential to strain water resources and 

valuable fish spawning habitat. Glaciers have historically provided a natural water storage 

buffer to support late summer baseflows but with a reduction in glacier volume, the water 

available during warmer months will be reduced. In the face of such changes, improved 
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water resource conservation and planning may become imperative to protect our natural 

resources. 
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7.0 Tables 

Table 1. List of GCMs and associated information used to model the effects of forecasted climate 

change on streamflow in the Nooksack River Basin. 
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Table 2. Median forecasted monthly temperature increases (degrees C) for 10 MACA downscaled 

GCMs under RCP 4.5 and 8.5 scenarios for Mount Baker (white rows) and the low elevation area 

near the North Cedarville gauge (gray rows) at 2099 compared to the 1950-2010 historical mean. 

Average monthly and annual temperature increases are shown in bold. The annual average value 

represents the mean annual ensemble temperature increase for both locations. 
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Table 3. Final calibrated monthly temperature lapse rates for the North, Middle, and South Fork 

basins of the Nooksack River. 
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Table 4. Calibrated constants and parameters for the DHSVM and coupled glacier dynamics model 

for the North, Middle, and South Fork basins. 
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Table 5. Glacier area and volume errors for the upper Nooksack River Basin for 1950 and 2009 

compared to observed areal ice extent. 
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Table 6. Calibrated model Nash-Sutcliffe efficiency scores, cumulative discharge error, and mean 

monthly streamflow error at the North Fork, Middle Fork, South Fork, and North Cedarville USGS 

stream gauge locations. North, Middle, and South Fork statistics represent 10-year calibration and 

validation periods while the North Cedarville statistics only represent a 5-year simulation due to a 

limitation of consistent stream gauge data at that location. 
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Table 7. Modeled changes in glacier melt magnitude for the North and Middle Fork basins of the 

Nooksack River as well as the North Cedarville gauge location for the years 2025, 2050, and 2075. 

Each percentage refers to a deviation from the historical (1950-2010) monthly median. 
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Table 8. Modeled percent of monthly median streamflow component derived from glacier ice melt 

for the North and Middle Fork basins and North Cedarville for historical and RCP 4.5 and 8.5 future 

scenarios. Historical melt component is a monthly median representing a 60-year simulation period 

from 1950-2010. Future results represent 30-year medians centered on 2025, 2050, or 2075. 
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Table 9. Projected changes in streamflow for the North, Middle, and South Fork basins of the 

Nooksack River for the years 2025, 2050, and 2075. Each percentage refers to a deviation from the 

historical (1950-2010) monthly median. 
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8.0 Figures 

 

Figure 1. The Nooksack River basin located in northwest Washington State. USGS stream gauges are 

shown with circles. Active SNOTEL stations at Elbow Lake (south fork), Middle Fork (middle fork), 

and Wells Creek (north fork) are indicated by dotted triangles. Weather stations are indicated by plus 

signs. The horizontal line across the top of the watershed indicates the United States-Canada border. 
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Figure 2. Elevation bands for the upper Nooksack River Basin indicating lower elevation (lighter 

colored) to higher elevation (darker colored) regions. The North, Middle, and South Fork basins are 

outlined in black. 
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Figure 3. Water and ice flux processes and how they are simulated by the coupled DHSVM and 

glacier dynamics model. Mass and energy fluxes as well as ice and snow-water equivalent determine 

monthly mass balance for each 50m grid cell (modified from Naz et al., 2014). 
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Figure 4. Center nodes of 1/16 degree Livneh grid overlain on the upper Nooksack River basin. Grid 

points are used as the locations for the Livneh meteorology forcing inputs. 
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Figure 5. Monthly median SNOTEL temperature observations (1995-2010) for the North, Middle, 

and South Fork basins compared with Livneh temperatures before and after a delta change correction 

was applied to eliminate a cold bias found when compared to PRISM 30-yr normals (1981-2010). 

The Middle Fork SNOTEL was not operational prior to water year 2003. 
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Figure 6. Daily SWE calibration results at the Wells Creek (North Fork), Middle Fork, and Elbow 

Lake (South Fork) SNOTEL site locations.  
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Figure 7. Top figure shows the initial ice extent and ice thickness for glaciated areas of the Middle 

Fork basin for year 1950 after model spinup. Estimated 1950 ice extent is indicated by the blue 

outline. Bottom figure shows the estimated ice extent and ice thickness for September of 2009 after a 

model run from 1950-2009. Digitized observed areal extent is shown in pink. 
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Figure 8. Top figure shows the initial ice extent and ice thickness for glaciated areas of the North 

Fork Nooksack basin for year 1950 after model spinup. Estimated 1950 ice extent is indicated by the 

blue outline. Bottom figure shows the estimated ice extent and ice thickness for September of 2009 

after a model run from 1950-2009. Digitized observed areal extent is shown in pink. 
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Figure 9. Comparison between simulated and observed annual glacier mass balance for the Sholes 

Glacier on Mount Baker in the North Fork Nooksack River basin for 1990 to 2010 (observations from 

Pelto and Brown, 2012). 
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Figure 10. Daily streamflow calibration results at North Cedarville and the North, Middle, and South 

Fork basins of the Nooksack River at their respective USGS stream gauge locations. Nash-Sutcliffe 

efficiency scores are shown in the upper right corner of each plot. 2006 was the first year of 

consistent record for the North Cedarville gauge. 
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Figure 11. Monthly median streamflow calibration results at North Cedarville and the North, Middle, 

and South Fork basins of the Nooksack River at their respective USGS stream gauge locations. Nash-

Sutcliffe efficiency scores are shown in the upper right corner of each plot. 
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Figure 12. Modeled and Observed cumulative discharge (a summation of each time-step) at North 

Cedarville and the North, Middle, and South Fork basins of the Nooksack River at their respective 

USGS stream gauge locations. The discharge error of the model is shown at the top right of each plot. 

Positive error indicates an overestimation of flow while negative error indicates an underestimation of 

streamflow. 
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Figure 13. Modeled historic (1950-2010) glacier ice melt contribution to streamflow in daily 

magnitude (cms; left plots) and as a percent of total median monthly streamflow (right plots) for the 

North Fork and Middle Fork basins as well as the North Cedarville gauge location. 
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Figure 14. Modeled future daily median basin average SWE for the North Fork (left plots), Middle 

Fork (middle plots), and South Fork (right plots) basins for all 10 GCMs under RCP 4.5 and 8.5 

scenarios. Historical flow line (black) represents a 60-year modeled median daily SWE magnitude 

(1950-2010) while each of the future scenarios (RCP 4.5 in red and RCP 8.5 in blue) represent 30-

year median daily SWE magnitudes centered on their respective year (2025, 2050, or 2075). Gray 

lines each represent the median SWE from an individual GCM and RCP scenario over a 30-yr period. 
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Figure 15. Modeled Nooksack River basin mean ice water equivalent and ice extent for the RCP 4.5 

(top figures) and RCP 8.5 (bottom figures) GCM ensembles for 2050 (left figures) and 2099 (right 

figures). Each ice extent is the average of the 10 ice thickness rasters produced by the model 

throughout the 21
st
 Century under each GCM. Estimated 2009 ice extent from Landsat imagery is 

outlined in pink. 
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Figure 16. Modeled daily median glacier ice melt for the North and Middle Fork basins of the 

Nooksack River for 2025 (top row), 2050 (middle row), and 2075 (bottom row). Historical median 

flow (black line) represents 60 years (1950-2010) of modeled ice melt while each of the future 

scenarios represent 30-year medians of the RCP 4.5 (red) and RCP 8.5 (blue) GCM ensembles. Gray 

lines each represent the median daily melt from an individual GCM and RCP scenario over a 30-yr 

period. 
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Figure 17. Modeled future daily median streamflows for the North, Middle, and South Fork basins 

for all 10 GCMs under RCP 4.5 and 8.5 scenarios. Flows for each basin are modeled at the location of 

the USGS gauge used for calibration. Historical flow line represents a 60-year median daily flow 

(1950-2010) while each of the future scenarios represent 30-year daily median flows centered on their 

respective year (2025, 2050, or 2075). Gray lines each represent the median flow from an individual 

GCM and RCP scenario over a 30-yr period. 
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Figure 18. Modeled future daily median streamflow for the North Cedarville Nooksack River gauge 

location for all 10 GCMs under RCP 4.5 and 8.5 scenarios. Historical flow line (black) represents a 

modeled 60-year median daily flow (1950-2010) while each of the future scenarios represent 30-year 

daily median flows centered on their respective year (2025, 2050, or 2075). Gray lines each represent 

the median flow from an individual GCM and RCP scenario over a 30-yr period. 
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Figure 19. Modeled Middle Fork monthly glacier areal extent from 1950-2010 (top) and annual mean 

PDO index (middle) and Multivariate El Nino Southern Oscillation index (bottom) for the same time 

period. 
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Figure 20. Modeled future median daily SWE at the Wells Creek (1228 m elevation), Middle Fork 

(1515 m elevation), and Elbow Lake (927 m elevation) SNOTEL gauge locations in the North, 

Middle, and South Fork basins respectively for 2025, 2050, and 2075. Historical flow line represents 

a 60-year median daily SWE magnitude (1950-2010) while each of the future scenarios represent 30-

year median daily SWE magnitudes centered on their respective year (2025, 2050, or 2075). Gray 

lines each represent the median SWE from an individual GCM and RCP scenario over a 30-yr period.  
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9.0 Appendix A. DHSVM Setup 

Much of this text was taken directly from a similar appendix in Carrie Donnell’s Master’s 

Thesis (2007) and in Susan Dickerson’s Master’s Thesis (2010). Additional comments and 

modifications were made by Ryan D Murphy (2015). 

 

1.0 CREATE A DEM GRID 

1.1 Create a workspace.   

1.2 Download and unzip Digital Elevation Models (DEMs).  

I used the following website, operated by the Washington State Geospatial Data Archive at 

the University of Washington: 

 

http://gis.ess.washington.edu/data/raster/tenmeter/byquad/index.html 

 

The projection of the DEMs are UTM, Zone 10, datum NAD 27, and units in meters.    All 

the final grids will be in this projection. 

 

1.3 Convert DEM files to raster files. 

Open ArcMap→Arc Toolbox→Conversion Tools→To Raster→DEM to Raster 

 

Input USGS DEM file: your.dem 

Output raster: <select drive to save to> →OK 

 

This will convert the DEM to a raster, and import the raster to ArcMap.   

All DEMs have to be converted to raster files individually. 

 

1.4 Mosaic DEMs. 

a. Access the Spatial Analyst toolbar:  View/Toolbars/Spatial Analyst  

 

Set analysis environment 

 From Spatial Analyst dropdown menu→Options   

Or Right click in toolbox to set environments 

 Under general tab, Working directory: e.g., U:/ThesisGIS2/dems. 

 Under Extent tab, Analysis extent: Union of Inputs 

 Under Cell size tab, Analysis cell size: Maximum of Inputs 

 →OK 

b. Mosaic the DEMs using Raster Calculator (or alternate method)    

Open Spatial Analyst toolbar → raster calculator   

Create the Mosaic expression in the text box: 

 <Nooksackdem>=mosaic ([deming], [CanyonLake], [etc.])  

 →Evaluate  (this takes a long time) 
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b2. Alternate method:  use the ‘Mosaic to new raster’ tool 

Open ArcToolbox→Data Management tools→Mosaic to new raster  

→Environments 

Under general tab, Working directory: U:/ThesisGIS2/dems 

 Under Extent tab, Analysis extent: Union of Inputs 

 Under Cell size tab, Analysis cell size: Maximum of Inputs 

 

c. Once DEMs are mosaic-ed, locate the new DEM in ArcCatalog and drag it into ArcMap.   

 

1.5 Resample DEMs to 50 m by 50 m pixel resolution.  

a. Set analysis environment (very important) 

Open ArcToolbox→Data Management tools→Raster→Resample→environment  

Under General Settings tab:  

Current Workspace: U:/ThesisGIS2/dems 

 Scratch Workspace: U:/ThesisGIS2/dems 

 Output coordinate system: Same as layer “Nooksackdem” 

 Output Extent: Same as layer “Nooksackdem” 

  Under Raster Analysis settings tab: 

 Cell size: 50 

Mask: None 

→OK  

 

b. Resample: 

Input Raster: “Nooksackdem” 

Output Raster: “dem50” (suggests an .img file extension, which I deleted) 

Cell size: 50 

Resampling Technique: Nearest 

→OK 

 

Once the mosaic-ed raster is resampled to 50m resolution, Nooksackdem (10 m resolution) 

can be removed from ArcMap. 

 

 

2.0 CREATE A WATERSHED MASK 

 

Note: This is very important! If using the coupled glacier dynamics model, the watershed 

mask must be the same as the glacier domain mask (see Glacier Module Guide). This means 

adding the glaciated area just outside of the watershed to the watershed mask produced in 

this tutorial. This will ultimately be the mask that every other spatial input will need to be 

clipped to and it must be the same (and have the same extent) as the glacier domain mask. 

 

2.1 Create another folder within the workspace.   

I titled mine “setup”. 
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2.2 Fill sinks to even out the DEM. 

Open hydrology/models toolbar→Fill Sinks 

Input surface: dem50 

Fill limit:  <Fill_All> 

Output raster: U:/ThesisGIS2/setup/fillsinks 

→OK  (This takes a long time) 

 

2.3 Perform flow direction on the filled DEM.   

This grid is necessary for determining the watershed boundary. 

Open hydrology/models toolbar→Flow direction 

Input surface: fillsinks 

Output raster: U:/ThesisGIS2/setup/flowdir 

→OK 

 

2.4 Perform flow accumulation.   

This grid is also necessary for determining the watershed boundary. 

Open hydrology/models toolbar→Flow accumulation 

Direction raster: flowdir 

Output raster: U:/ThesisGIS2/setup/flowacc 

→OK 

 

2.5 Set interactive properties to create a watershed boundary. 

Open hydrology modeling toolbar→Interactive properties 

Flow direction: flowdir 

Flow accumulation: flowacc 

→OK 

 

2.6 Create the watershed boundary and mask. 

Click the watershed button from the hydrology modeling toolbar. 

 

This is an interactive tool which will determine the boundary of the watershed based on the 

destination cell.  I selected the point downstream of the North Cedarville USGS gauging 

station and ArcGIS determined which cells would eventually drain water to that point.  I had 

to repeat the process a few times before I was satisfied with the watershed boundary.   

 

When a watershed is created, it is a temporary file.  Make it permanent, right-click on the 

watershed grid in ArcMap table of contents→Make Permanent→set source to the current 

workspace (U:/ThesisGIS2/setup/nf).  This raster file will be used as the “mask” input for 

DHSVM. 
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If you need to erase rasters from one another (to isolate sub-basins for example), the raster 

calculator can be used. Note: the “Erase” tool only works on polygons, so unless you want to 

convert everything to polygons, erase, then convert back to rasters, the raster calculator is the 

best option. 

 

To use the Raster Calculator to erase one or more rasters from another, open the Raster 

Calculator tool (Spatial AnalystMap AlgebraRaster Calculator) and enter: 

 

SetNull(~(IsNull([Erase Raster])),[Original Raster]) 

 

Note: For ArcMap version 9.X.X, replace “~” with “Not” 

 

Where Erase Raster is the raster/area that will be taken out and erased from the Original 

Raster. If you need to remove more than one raster from a larger raster, simple type the 

above command, add a space, type “&” (without the quotations), then type the same 

command but input the other Erase Raster. 

 

2.7 Once the watershed mask is created, it can be used to clip the DEM and hillshade 

(optional) to the watershed.   

 

The polygon of the watershed can also be used to clip other grids to the watershed, but be 

careful that the polygon was not simplified, because the final mask needs to have the same 

number of rows and columns as each of the clipped coverages. 

 

Open ArcToolbox→Spatial Analyst Tools→Extraction→Extract by Mask 

 

Input raster:  U:/ThesisGIS2/dem/dem50 

Input raster or feature mask data:  nook 

Output raster:  U:/ThesisGIS2/setup/nookdem 

→OK 

 

Alternatively, you can use the raster calculator for this step (or any extraction step). 

 

2.8 Extract a clipped DEM with filled sinks.   

 

This will be needed for running the AML (see below).   

Open ArcToolbox→Spatial Analyst Tools→Extraction→Extract by Mask 

 

Input raster:  U:/ThesisGIS2/setup/fillsinks 

Input raster or feature mask data:  nook 

Output raster:  U:/ThesisGIS2/setup/nookdemf 

→OK 
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I used an f at the end of a dem name to indicate that it is filled, and an flt to indicate that it 

had been converted to floating point (see below). 

 

 

3.0 CREATE A LANDCOVER GRID 

3.1  Download landcover grid 

I used the 2006 NOAA landcover grid available publically. Additionally, I used an historical 

landcover grid developed for the lower Nooksack Water Budget (Bandaragoda et. al., 2012) 

to test the impact of landcover change on streamflow. 

 

The NOAA landcover file was already an ESRI grid, so it does not need to be converted.  

The PCS may be different than that for the DEM, but ArcGIS should be able to project the 

grid on the fly.    

 

3.2 Resample grid to 50 by 50 m resolution. 

Open ArcToolbox→Data management Tools→Raster→Resample 

Set the analysis environment (very important): 

Under General Settings tab:  

Current Workspace: (U:/ThesisGIS2/setup) 

 Scratch Workspace (U:/ThesisGIS2/setup) 

 Output coordinate system: Same as layer “nookdem” 

 Output Extent: Same as layer “nookdem” 

  Under Raster Analysis settings tab: 

 Cell size: 50 

Mask: None 

→OK to close environments setting 

 

Input raster: landcover 

Output raster: landcover50 

Output cell size: 50 

Resampling technique: nearest neighbor 

→OK 

 

3.3 Clip landcover grid to watershed boundary. 

Open ArcToolbox→Spatial Analyst Tools→Extraction→Extract by Mask 

→Environment 

Working directory: U:/ThesisGIS2/setup 

Analysis mask: nook 

Extent: nook 

Cellsize: 50 

→OK 
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Input raster:  U:/ThesisGIS2/setup/landcover50 

Input raster or feature mask data:  nook 

Output raster:  U:/ThesisGIS2/setup/nookveg 

→OK 

 

3.4 Reclassify NOAA vegetation classifications to DHSVM classifications. 

Open ArcToolbox→Spatial Analyst→Reclass→Reclassify 

Set general and raster analysis environments 

Input Raster: nookveg 

Output Raster: reclassveg 

Reclass Field: Value 

 

Then: 

NOAA Landcover classifications are different from the landcover classifications in DHSVM.  

Read the Coastal NLCD Classification Scheme and match land cover types with vegetation 

descriptions in the DHSVM configuration file as closely as possible.  I used the following 

values for the reclassification: 

 

NOAA NOAA DHSVM DHSVM 

11 Open Water 9 Water 

21 Developed, Open Space 3 Developed 

22 Developed, Low Intensity 3 Developed 

23 Developed, Med Intensity 3 Developed 

24 Developed, High Intensity 3 Developed 

 31 Barren Land (rock/sand/clay) 8 Rock 

41 Deciduous Forest 4 Broadleaf 

42 Evergreen Forest 1 Large Conifer 

43 Mixed Forest 2 Large Mixed Stand 

52 Shrub/Scrub 6 Shrubland 

71 Grassland/Herbaceous 7 Sparse/Open/Agriculture 

81 Pasture/Hay 7 Sparse/Open/Agriculture 

82 Cultivated Crops 7 Sparse/Open/Agriculture 

90 Woody Wetlands 10 Wetland 

95 Emergent Herbaceous Wetlands 10 Wetland 

These are the landcover reclassifications used by Ryan Murphy (2015) but may have to 

change if using a different landcover grid. 

 

 

4.0 CREATE A SOIL TEXTURE GRID  

Ryan Murphy (2015) used STATSGO soils from the USDA NRCS 

4.1 Download soil texture coverage  

STATSGO for the study area can be downloaded from one of the following sites:  
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http://websoilsurvey.sc.egov.usda.gov/App/HomePage.htm 

http://www.soilinfo.psu.edu/index.cgi?soil_data&statsgo 

 

4.2 Convert file.   

This is a GIS export file that has to be converted in ArcCatalog. 

Open ArcCatolog→Conversion Tools→Import from Interchange File 

Input file: C:\MFdhsvm\soil\wa.e00\wa.e00 

Output dataset: C:\MFdhsvm\soil\wa 

The file will now appear in ArcCatolog and can be dragged into ArcMap. 

The PCS may be different than that for the DEM, but ArcGIS should be able to project the 

grid on the fly.    

 

4.3 Convert soil polygon to raster. 

Open ArcToolbox→Conversion Tools→To Raster→Feature to Raster 

Set analysis environments by clicking on the Environments button 

Under General Settings tab:  

Current Workspace: (C:/MFdhsvm/soils) 

 Scratch Workspace (C:/MFdhsvm/soils) 

 Output coordinate system: Same as layer “Nooksackdem” 

 Output Extent: Same as layer “Nooksackdem” 

  Under Raster Analysis settings tab: 

 Cell size: 50 

Mask: None 

OK to close environments setting 

 

Input features: wa polygon 

Field: MUID 

Output raster: C:\MFdhsvm\soil\wa.e00\wa\soilgrid 

Output cell size: 50 

→OK 

 

Remove wa polygon from ArcMap 

 

4.4 Clip soil grid to watershed. 

Set analysis environment: 

Click Spatial Analysts toolbar→ Options 

Working directory: C:/MFdhsvm/soils 

Analysis mask: watershedpoly 

Extent: watershedpoly 

Cellsize: 50 

 

From Spatial Analyst dropdown menu→raster calculator 

Type the expression: soilshed=soilgrid 



75 

 

→Evaluate 

 

Soil classifications are as follows:  

 

MUID Description MUID Description 

1 Sand 10 Sandy Clay 

2 Loamy Sand 11 Silty Clay 

3 Sandy Loam 12 Clay 

4 Silty Loam 13 Organic (as loam) 

5 Silt 14 Water (as clay) 

6 Loam 15 Bedrock 

7 Sandy Clay Loam 16 Other (as SCL) 

8 Silty Clay Loam 17 Muck 

9 Clay Loam 18 Talus 

 

 

Dickerson (2010) notes the following problems and possible solutions: 

 

Although the hydrology of the Nooksack River basin is not likely to be highly sensitive to 

soil types due to relatively shallow soil depths on steep, mountainous slopes, I found a few 

problems with the above methodology, and chose to use a soil type dataset derived 

specifically for hydrology modeling.  First, the association of the map unit identification 

(MUID) with the “value” is eliminated during the clipping process.  The MUID numbers in 

the table, above, are actually value numbers.  To retain the MUID, you must use “Joins and 

Relates” to join the two attribute tables based on Value.  The MUID is the link to all 

information in the STATSGO database including the comp table and the layer table (which 

are included in the download of the wa.e00 file).  Each map unit has up to 21 components 

with no spatial resolution (e.g. 24% of a map unit is one soil composition, but there is no 

spatial information about the distribution), and each component can have up to 7 layers, all of 

which are linked in attribute tables via the MUID (USDA/NRCS, 2001).  The classification 

scheme, above, which relates a Value to a Soil Type appears to be from the Wiley and 

Clancy Washington soil dataset that I use, described below, rather than a direct usage of the 

STATSGO database.  In applying the above classification scheme to the STATSGO data and 

then comparing the soil types to the Wiley and Clancy data for the same area, there were 

conflicting soil type classifications.   

 

An alternate method could be to use the surface texture (“SURTEX”) characteristic 

associated with each map unit, or to use the dominant texture grid from the CONUS database 

on the STATSGO website: 

http://www.soilinfo.psu.edu/index.cgi?soil_data&conus&data_cov&texture&datasets&geo 

(the CONUS coverage is a large file (10 Mb) because it covers the entire United States). 
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5.0  CREATE SOIL DEPTH AND STREAM NETWORK GRIDS 

I created the soil depth and stream network grids using Arc (Arc is a command line version 

of ArcGIS, and accessible through the ArcInfo Workstation menu options).   

 

To get to Arc:  Start->ArcGIS->ArcInfo Workstation->Arc (command line prompt pops up) 

 

Helpful Arc commands:  

(more available from “ArcDoc” accessed through the ArcInfo workstation): 

workspace lists current workspace 

listgrids lists grids in current workspace 

quit (or q)  leave grid session and back to Arc prompt, or end Arc session 

 

 

5.1 Reclassify the watershed mask (e.g. nook). 

The watershed mask values must be defined as inbasin=1 and outside basin=NODATA.  

Otherwise the AML will create a stream network for the entire raster.  You can check the 

values in ArcMap by opening the DEM properties dialogue. 

 

Open ArcToolbox→Spatial Analyst Tools→Reclass→Reclassify 

Input raster: U:/ThesisGIS2/setup/nook 

inbasin=1 and NODATA (outside basin)=NODATA 

Output polygon features: U:/ThesisGIS2/setup/Reclass_nook 

→OK 

 

 

5.2 Create a workspace. 

Create a new folder:  C:/yourname_dhsvm/nook/streams 

 

The AML only works for me when I run it directly from the hard drive rather than a 

networked drive or an external hard drive.  Also, there is much discussion on the DHSVM 

archive about the finicky nature of the createstreamnetwork aml; tips gleaned from that 

website include:  close ArcCatalog and ArcMap before running the AML (so that the needed 

files are not open or being accessed), and always begin with a new, completely empty folder 

for each AML run so that you do not inadvertently carry over files that were created during 

the previous run of the AML.   

 

Note: I had issues with incorrect outputs when using the AMLs from the newest DHSVM 

tutorial (version 3.1). Using an older AML version worked.  

 

Obtain the AML scripts from Bob Mitchell or the DHSVM tutorial online 

(http://www.hydro.washington.edu/Lettenmaier/Models/DHSVM/index.shtml  (To do this, 

download tutorial.tar.gz (save, not open), Find the file in the windows folder; double click, “I 

http://www.hydro.washington.edu/Lettenmaier/Models/DHSVM/index.shtml
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agree” when winzip pops up, select all and “extract”; AML scripts are in the arcinfo folder 

that is created by extracting the files.) 

 

In ArcCatalog:  Copy the reclassified mask, the filled, clipped dem (nookdemf) and 

amlscripts from the DHSVM tutorial into the “streams” folder. 

 

Check the computer to ensure that it has a Java Runtime Environment (JRE).  If it doesn’t, 

download Java software from www.sun.com. 

To check for JRE, open Arc and type: 

Arc: &sys java –version 

If the JRE is installed, you should get: 

Java version “1.6.0_11”  (I used 1.4.2_05, on Bob Mitchell’s lab computer) 

Java [TM] SE Runtime Environment, Standard Edition (build 1..6.0_11-b03) 

Java HotSpot[TM] Client VM (build11.0-b16, mixed mode, sharing). 

 

5.3 Check file paths for AML. 

If you are using a folder that is titled something aside from “streams”, make sure to change 

the filepath for AddAat2.class within the createstreamnetwork AML, before running the 

AML. 

 

The scripted is coded to look in the streams folder, so if this step is skipped, the AML will 

encounter an error, but will continue to run anyway.  It will produce zeros within the 

streamnetwork.dat for slope, segorder, etc. and DHSVM cannot use this file.    

 

To change the filepath,  open the AML as a text file (e.g., using Wordpad) and use the ‘find’ 

tool (find “AddAat.2”) to locate the path and changed the path to your soildep folder instead: 

&sys java -classpath ../soildep/amlscripts/AddAat2 %streamnet% 

 

5.4 Convert filled dem to floating point and run the AML      

Open ARC.  Type: 

ARC: &workspace C:/Susan_dhsvm/nook/streams 

ARC: grid 

GRID: nookdemflt = FLOAT(nookdemf) 

GRID: q 

ARC: &watch aml.watch 

ARC: &amlpath C:/Susan_dhsvm/nook/streams /amlscripts  

ARC: &run createstreamnetwork nookdemflt nook_mask nooksoildep1 nookstreams1 

MASK 220000 0.76 1.5 

 

Where ‘nookdemflt’ is the clipped, filled dem coverted to floating point; ‘nookdemf’ is the 

clipped, filled dem; ‘nook_mask’ is the reclassified raster mask; ‘nooksoildep1’ and 

‘nookstreams1’ are the names I chose for output files.  

 

http://www.sun.com/
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The last three numbers are variables representing the minimum contributing area before a 

channel begins, the minimum soil depth, and maximum soil depth (in meters).  I used a 1 at 

the end of each of the output files to distinguish them from future files, when the AML is run 

again with different soil depths (e.g. nooksoildep2 may range from 0.76 to 2.5 m). 

 

This process takes a long time (approximately 45 min for Middle Fork 388x514 pixel grid).  

Just before the script finishes running it will ask you if you want to continue.  Answer ‘y’ for 

yes, and it will finish the process.   

 

Output from this step includes:  soil depth raster (nooksoildep), a stream network feature 

class, stream.map.dat, and stream.network.dat (note that the two .dat files only appear when 

the folder is viewed with Windows, not in ArcCatalog.  Open stream.network.dat with 

Wordpad to check whether the AML has run properly; if it has, there will be a variety of 

numbers in the last two columns rather than all zeros. 

 

I ran this step multiple times – for each basin that I created and then changing the soil depth 

for calibration of the model.  Each time I renamed the “streams” folder (e.g., to streams_1.5), 

and then created a new stream folder by copying in the needed inputs.  This is because the 

program will overwrite the files that are named the same way every time the AML is run 

(e.g., stream.network.dat) 

 

 

6.0 CREATE A SERIES OF SHADING MAPS 

6.1 Create a workspace. 

Create a new folder: C:/Susan_dhsvm/northfork/shadow 

 

Copy the clipped dem and watershed mask into this folder using ArcCatalog.     

 

The solar AML (process_solar or process_solar1) and 3 “C” files, 

make_dhsvm_shade_maps.exe, skyview.exe, and average_shadow.exe are available from 

Robert Mitchell; they are not available in the amlscripts folder in the DHSVM tutorial.  

Carrie Donnell compiled these using the ‘lcc’ compiler in the Computer Science department 

with the help of Matt Paskus.  Copy the amlscripts folder with the aml, and the .exe files into 

the ‘shadow’ folder.  Note that the three .exe files should be in the shadow folder directly, 

rather than in the amlscripts folder. In addition, make sure that a copy of cygwin1.dll is 

located in the shadow folder as well. Arc cannot find the .dll otherwise and it is needed in 

order to run the skyview.exe. 

 

6.2 Run the AML 

Arc: &workspace C:/Susan_dhsvm/northfork/shadow 

Arc: &watch aml.watch 

Arc: &amlpath C:/Susan_dhsvm/northfork/shadow/amlscripts 

Arc: &r process_solar nook nookdem 3 0.0 
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Arc: q 

 

The watershed mask is nook, and the dem is nookdem.  The last two numbers represent the 

model timestep (I used 3 hours) and GMT offset, respectively.  Robert Mitchell’s previous 

DHSVM set-up instructions have noted that Matt Wiley (formerly of UW, currently of 3Tier 

in Seattle) usually uses 0 as the GMT offset; it's a little confusing, in that the time stamp on 

the model runs is then off by 8 hours, for example the warmest part of the day is at 8:00 pm, 

but that works better when using daily data with the met record creation programs, and 

avoids the confusion of daylight savings time, times zones etc. 

 

At the end of the session Arc will state that the AML command “rm” is not recognized in 

Windows; however, it produced the needed output (which are 12 shadow maps and a 

skyview file, all of which are .bin files and will not be visible in ArcCatalog).  Transfer the 

shadow maps to Horton, and rename each file (ex: ‘Shadow.01.hourly.bin’ is renamed 

‘shadow.01.bin’). 

 

Note from Ryan Murphy (2015): I had some issues with this process producing incorrect 

shading maps. Ultimately, I used a shell scripting method in Linux which gave more control 

over some of the commands. This seemed to work and did not involve the need for compiling 

code on the Windows machine. The scripts needed to do this are available within the tutorial 

available on the DHSVM website. There is a lot of hardcoded stuff in some of the scripts 

(number of maps to produce, etc) so look for that. 

 

 

7.0 CONVERT DEM, SOIL TYPE, SOIL THICKNESS, VEGETATION, AND WATERSHED 

FILES TO ASCII GRIDS 

 I created a new file for each conversion and copied the GIS grid to be converted into the file.   

I then convert all the NoData values in the grids to something that DSHVM recognizes (e.g., 

water=14) and converted the grids to ascii format. 

 

For DEM, Soil Type, Soil Thickness, and Vegetation:  

 

Example: 

For the nooksack DEM, Type: 

Arc: &workspace U:\ThesisGIS2\setup 

Arc: grid 

GRID: nookdem.asci = gridascii(con(isnull(nookdem),14,nookdem)) 

 

Repeat for all dem, soil type, soil thickness, and vegetation grids. 

 

GRID: q 

ARC: q 

 

NOTES:   
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 the term before the equal sign is the new file name; the “.asci” is just to remind me 

that it is an ascii file. 

 there is no space between & and workspace 

 there is a space on either side of the equal sign, the function will not work if you have 

a space in the wrong place. 

 the new file will not appear in Arc Catalog, but a “projection” file will be created 

along with it that ArcCatalog will see; the new file can be viewed in Windows via 

“My Computer”. 

 

 

For the Mask: 

Use the re-classified watershed raster.  Use 0 rather than 14 for the no data values 

 

GRID: nook_mask.asci = gridascii(con(isnull(nook_mask),0,nook_mask)) 

 

 

8.0 TRANSFER ASCII GRIDS FROM WINDOWS TO A UNIX SYSTEM 

All of the ascii files need to be transferred to Luna, the Unix system in Robert Mitchell’s 

laboratory.  The transfer requires a secure shell (e.g. WinSCP or SSH); the address for Luna 

is: 

 

luna.geol.wwu.edu 

 

Transfer the ascii files to the Input directory.  Additionally, transfer stream.network.dat and 

stream.map.dat (stream.network.dat and stream.map.dat were created by the aml in Step #6), 

the twelve shadow maps, skyview file, and the meteorological input file to the Input 

directory. 

 

 

9.0 CONVERT ASCII GRIDS TO BINARY (on Horton) 

Open the ascii Files using EMACS (a UNIX word processing program), and read/record first 

six lines (# of rows, columns, etc.), and then delete them.  The files can also remain in your 

PC workspace for future reference of the first six lines.  Check that each ascii file has the 

same number of rows and columns – a difference in the size of the grids will prevent 

DHSVM from running.   

 

Convert the ascii gids (e.g. nookdem.asci) to binary files using “myconvert” (a program 

available from Robert Mitchell) in the Input directory.  

  

The correct variable type for each grid is: 

mask, landcover, soil type: uchar  

dem, soil depth: float 

  

Example (for mask, land cover, soil type): 
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horton > ./myconvert ascii uchar nookmask.asc nookmask.bin 366 430 

 

Example (for dem, soil depth): 

horton > ./myconvert ascii float nookdem.asc nookdem.bin 366 430 

 

Where: 

horton> ./myconvert source_format target_format source_file target_file number_of_rows 

number_of_columns 

 

 

10.0 CREATE A FINAL STREAM MAP AND STREAM NETWORK FILE 

Use the program “assign” (a program available from Robert Mitchell) to create a final stream 

map and stream network.  stream-net.dat and stream-map.dat are the final map and network 

files. 

 

Example: 

horton>./assign stream.network.dat stream.map.dat stream-net.dat stream-map.dat 

 

I used the hyphen to indicate that the file that has been “assigned”. 

 

 

11.0  Locate the stream gauge for DHSVM calibration. 

The stream gauge location in DHSVM is based on the location of the end of a stream 

segment generated in the stream network aml, not the actual location of the gauge.  Open 

ArcMap and add the stream network Arc to the map if needed.  Locate the position of the 

stream gauge using the coordinate indicators in the lower right corner of the screen, or plot 

the location of the stream gauge using “Tools” and “add X Y data”.  The output segment is 

the segment that terminates the closest to the stream gauge location.  Stream discharge is not 

at a pixel, it is at the end of a selected stream segment.  After the stream gauge is located, 

click on the stream segment nearest the gauge using the “INFO” button to determine the 

stream segment ID #.  Record the segment number/value.  On Horton, open the final stream 

network file using EMACS, and type ‘SAVE’ next to the appropriate stream segment. 

 

Then, copy the final stream files (stream-net.dat and stream-map.dat) into the state directory. 

 

 

12.0  Locate the PIXELs for SWE OBSERVATIONS. 

Determine coordinates for pixel dumps that will be used for SWE calibration.  Exact 

locations of SNOTEL stations are available by contacting NRCS (the locations on the 

website are intentionally vague).  Use ArcMap to locate the pixel, and check the elevation, 

aspect, and land cover for that location.  If necessary, move the SNOTEL location to a 

nearby pixel that has the correct characteristics, or reclassify the pixel.  For example, for 
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accurate simulation of SWE the pixel must not have over-story vegetation (i.e., it should be 

classified as urban, bare, or grassland).   

 

 

13.0 SET INITIAL CONDITIONS FOR DHSVM CALIBRATION 

13.1 Create initial channel state files: 

In the State Directory, type: 

horton>  awk ‘{print $1, 0.1}’ stream-net.dat> Channel.State.09.30.2005.23.00.00 

 

The Channel.State filed should be named for the day and last time step before the water year 

you will simulate (09.30.2005.23.00.00 for simulating WY 2006). 

 

13.2 Create model state files 

First: 

Edit InitialState.txt (available from Bob, or from the dshvm tutorial):  change the starting 

date (e.g 9-30-05-23 for running a simulation of water year 2006, which begins on 10/1/05), 

and the number of rows and columns in the grids (previously deleted from the ascii files). 

 

Then: 

Run the MakeModelStateBin program with the following syntax: 

horton> ./MakeModelStateBin InitialState.txt 

 

This creates the initial Interception, Snow, and Soil state files for the date that is specified in 

the InitialState.txt file.  The date indicates the beginning of the model simulation. 

 

 

14.0  SET UP INPUT FILE 

Edit the DHSVM configuration file using EMACS, including specifications for:  start and 

end dates and times, UTM coordinates for extreme NW corner of mask, pixel size, names of 

binary inputs (e.g., soil, soil depth; note that file names are case sensitive), location of 

meteorological station, location of pixel dumps (e.g., SNOTEL stations), soil parameters, 

temperature and precipitation lapse rates, and other parameters. 

 

 

15.0 RUN THE MODEL 

From the main directory (horton/dickers/dhsvm/nooksack/nook>) 

horton> DHSVM input.nook  (note:  DHSVM command is case sensitive) 

or 

horton> time DHSVM input.nook 
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Where DHSVM is the command, and input.nook is the configuration file (a text file); the 

addition of “time” to the beginning of the command will print the elapsed time at the end of 

the simulation. 

 

Another useful command is: 

horton> nohup DHSVM input.nook & 

 

This will allow DHSVM to run in the background without terminating when you “hang up” 

the connection by logging off Horton or powering off your remote PC. 

 

 

16.0 RE-RUN THE MODEL with NEW INITIAL CONDITIONS 

Create initial conditions using the steps above, run the model for a year or more (the “spin-

up” period), and then use the output conditions from the first simulation as the initial 

conditions to re-run the model for the same year.  To do this, copy the output states (in the 

Output directory) to the State directory and rename them to be consistent with the first date 

and hour of the next simulation. 
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10.0 Appendix B. Glacier Model Setup 

September 2015 

This document was created by Ryan Murphy (Master's candidate at Western Washington University) 

and is based on the DHSVM Glacier Model Tutorial (dated 3/19/2014) from Chris Frans (University 

of Washington) and personal communications with Chris Frans and Christina Bandaragoda 

(University of Washington). 

 

DHSVM Coupled Glacier-Hydrology Model Options 

To calibrate and run the glacier dynamic glacier model for use with the DHSVM version 3.2 (as of 

this document's creation) is a multi-step process requiring iterative runs of the model under different 

settings. DHSVM has four glacier model run options: 

 

1. NO_GLACIER = Runs DHSVM routine without simulating glacier ice. Snow that reaches 

the density of ice is removed. 

 

2. GLSPINUP = Runs glacier model independently (i.e. with no DHSVM) with annual average 

mass balance forcing at an annual time step for 1000 years to “grow glaciers” to steady state 

(need to specify Glacier Mass Balance File in input configuration file) 

 

3. GLSTATIC = Runs DHSVM simulation representing a glacier ice layer (Surface Topography 

Input –  Bed Topography Input), however no glacier flow dynamics are included (ice is static 

and does not flow cell to cell; mass is finite) 

 

4. GLDYNAMIC = Runs DHSVM simulation representing glacier ice and glacier ice dynamics 

(ice flows cell to cell based on glacier ice physics) 

 

General Outline for Setting up and Running the Glacier-Hydrology Model: 

1. Estimate bed topography 

2. Estimate Mass Balance Field 

3. Run “GLSPINUP” with mass balance field to grow steady state glaciers 

a. Iterate by perturbing mass balance field until glacier outlines match historical extent 

estimate 

b. Once satisfied with simulated extent, use ice thickness and bed topography to create 

surface topography field 

4. Use surface topography field as input to initialize glacier states (Glacier Ice = Surface 

Topography – Bed Topography) in coupled glacier-hydrologic simulations (GLDYNAMIC, 

GLSTATIC) 

 

In order to run the coupled glacier-hydrology model properly, several steps must be taken. A 

representative mass balance field for the domain, as well as a surface topography field must be 

estimated. The DHSVM is used to estimate these parameters under the GLSTATIC and GLSPINUP 

glacier options. Once these files have been created, the dynamic model can be run and the static 

model can be run with more confidence. 
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Necessary Inputs: 

All inputs for the glacier portion of the model can be created or altered in ArcMap. The user should 

first decide which years they would like to model the glacier (i.e. starting with current glacier extent 

vs starting with the extent from the year 1950 for example). Typically the oldest observed glacial 

extent is used. This will largely depend on what GIS datasets (NOCA, GLIMS, etc.) are available.  

Make sure to specify the correct cell size and extent for you rasters. The grid spacing and number of 

rows/columns must match the other inputs to the model (DEM, mask, landcover, etx.). 

 

Note: Pixels with no data should have values of 0 rather than -9999. 

 

Glacier Mask File 

After obtaining the historical glacier GIS dataset, isolate the glaciers that have at least part of their 

extent within the watershed of interest. Glaciers directly adjacent to the study area watershed should 

also be selected. Create a subset layer with just these glaciers. Do not clip to the watershed boundary. 

Include the entire glacier in the new layer even if only part of it enters the watershed. If this layer is a 

polygon, convert to a raster using the polygon to raster tool. 

 

Reclassify the raster so that non-glaciated pixels have a value of 0. Currently, the code is set up to 

output glacier mass balance and area for two individual glaciers, which should be reclassified with 

integer values 6 and 7. All other glaciated areas should have a value of 1 (see below for example). 

 

 
 

Glacier Domain Mask 

Similar to the watershed mask, this file identifies an area that includes all the glacial bodies connected 

to the watershed. Glacier flowsheds do not always correspond to watershed boundaries. Because ice 

at watershed boundaries can flow into and out of the watershed, this larger mask is required for the 

glacier model. This domain should be large enough to include all of the ice bodies that have portions 

that flow into the watershed. Glaciers directly adjacent to the study area watershed should also be 

included (the same ones as in the glacier mask). See figure below. 
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The domain should not have any holes in it. If necessary, buffer the glacier extent to remove any 

“NoData” pixels within the domain. 

 

This can be created using the Mosaic to New Raster tool in ArcMap using the watershed mask and 

the glacier mask file as inputs.  

 

Glacier Bed Topography 

This file is the elevation field of the entire domain, and represents the topography under the current 

glacier extent. Simply stated, this file is equal to the DEM outside of the glacier and is less than the 

DEM under the glaciated areas. The methods Clarke et al. 2012 have been used to estimate bed 

topography in past applications. 

 

Unless ground penetrating radar or other data are available for the study area, the basin domain DEM 

is used. This likely provides a good estimate where glaciers are relatively small. I used a DEM 

clipped to the entire rectangular extent, not just the basin mask, since there were some glaciated areas 

outside of the basin. 

 

Glacier Surface Topography File 

This file is an estimate of the initial ice thickness. This file cannot be created until the SPINUP mode 

is run, but there are several steps before that can happen. A run using the GLSTATIC option must be 
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performed, which is necessary to estimate mass balance which is needed for the surface topography 

file. These steps are outlined below in the “Running the Model” section. 

 

One DEMs is needed for the first GLSTATIC run and one DEM is needed for calibration: 

1. Create a grid file that represents a thick layer of ice across the entire domain. This can be 

done by adding 1000m to the domain DEM of the entire area using the Raster Calculator. 

This layer will ultimately help track changes in mass balance over time (explained more in 

the “Running the Model” section). 

 

2. Create a DEM that represents a thick layer of ice across only the glaciated areas. Do this by 

adding 1000m (or some large number) to the glaciated areas. This can be done in a number of 

ways. I extracted the glaciated DEM area using the Extract by Mask tool with the original 

DEM being the input file and the glacier mask being the “mask” file. I then used the Raster 

Calculator to add 1000 to the newly created DEM of just the glacier area. The Raster 

Calculator can then be used again to add the glacier area DEM plus 1000m layer to the 

original DEM. This layer will ultimately help determine how much streamflow is coming 

from the static glaciated areas (explained more in the “Running the Model” section). This can 

be used in the calibration process. Note: this is not strictly necessary but does help to get 

baseline glacier melt results during calibration. 

 

Basin Mask File 

This is the same as the watershed mask. 

 

Glacier Mass Balance File 

This file will be created by the DHSVM after the GLSTATIC mode is run. An output file called 

“balance_sum.bin” will be produced. Convert this file from binary to ascii, add in the basin header 

(six lines containing the spatial information, gid size, and NoData values), and import back into 

ArcMap using the ASCII to Raster tool. This file represents the cumulative mass over time and needs 

to be divided by the number of years in the simulation run (using the Raster Calculator) to get the 

mean annual mass balance (explained more in the “Running the Model” section). 

 

Running the Model 

 

Model with No Glacier 

To run the model without any glacier component (no glaciers are simulated, static or otherwise), set 

the glacier option under the constants section to NO_GLACIER. This will produce a simulation for 

basin hydrology that does not include glacier melt. Under this mode type, snow that reaches the 

density of snow will be removed by the DHSVM. 

 

Dynamic Glacier Modeling 

To run the dynamic glacier model, two simulations must be performed first to estimate the mass 

balance and glacier ice thickness. Note: this is a general procedure for setting up and running the 

dynamic glacier model and does not include all of the steps for the initial glacier calibration. For more 

detailed calibration procedure/recommendations, see the “Calibration” section. 

1. Run the DHSVM with the glacier component option set to GLSTATIC. This step will 

estimate the mass balance field for the area. Input files are as follows: 
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 Domain Mask File = the file generated in the Glacier Domain Mask step above 

 Glacier Mask File = the file generated in the Glacier Domain Mask step above 

 

 In this case, the full domain is used instead of the glacier mask for calibration 

purposes. 

 

Typically DHSVM can have a habit of accumulation of snow/ice in areas where 

glaciers do not exist. This phenomena is really small when the model is well 

parameterized and calibrated, but can be large when not. The problem when running 

future warmer climate scenarios is that this ice will eventually melt, in turn 

simulating a future source of water that should not be there. Therefore, the mass is 

removed as it accumulates. So, prior to imposing this constraint where ice outside of 

the glacier mask is removed, what I have done, and what I recommend, is that when 

doing initial model calibration and testing, set the glacier mask to be the same as the 

domain mask. This way ice can accumulate and the glaciers can flow anywhere they 

want. In the end when you have a good calibration, the glaciers should stay close to 

where they are observed to be, and only a minimal amount of ice will accumulate 

outside the mask. At this point you can go ahead and use the glacier mask file 

reflecting real historical glacier outlines and you can run your simulations without the 

worry of generating small artificial ice reservoirs that will melt in the future. 

 

 Glacier Bed Topo File = basin DEM from the Glacier Bed Topography step above 

 Glacier Surface Topo File = use the DEM that represents a thick layer of ice across 

the entire domain (DEM+1000m everywhere). 

 Basin Mask File = watershed mask 

 Glacier Mass Balance File = not required. I use a placeholder such as the glacier 

surface topo file 

 

Change the input file for the DHSVM. I recommend saving a new input file for the 

GLSTATIC model run. This simulation should be run for a time period of 10 years or more 

to get an accurate measure of mean annual mass balance. 

 

After the model finishes, an output file called “balance_sum.bin” will be produced. This 

represents the mass balance for the simulation period. The annual mass balance is calculated 

by tracking the changes in ice and snow water equivalent through time. Having a thick layer 

of ice everywhere is required so that negative mass balances can be tracked at elevations 

outside of the current ice extent.  

 

Convert this file from binary to ascii using “MyConvert,” add in the basin header (six lines 

containing the spatial information, gid size, and NoData values), and import back into 

ArcMap using the ASCII to Raster tool. This file represents the cumulative mass over time 

and needs to be divided by the number of years in the simulation run (using the Raster 

Calculator) to get the mean annual mass balance. 

 

Convert the mean annual mass balance layer to ascii, transfer to the Unix machine, convert 

into binary using “MyConvert.” This file will be used as the Glacier Mass Balance file for the 

SPINUP run. 
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Temperature and precipitation fields have also been used with a temperature index model to 

generate the annual mass balance field; however, using DHSVM to generate the field 

includes the representation of energy balance terms as well as the effects of topography 

(shading, skyview, etc.). 

 

2. Now that the bed topography (the DEM) and mass balance fields have been created, you must 

estimate initial glacier ice thickness. This requires running the model for a spin-up time 

period so that the ice thickness profiles are physically realistic and mathematically stable. 

Change the glacier mode to SPINUP. Executing the model with this option will run the 

glacier model independently at an annual time step for 1000 years using the annual mass 

balance field that is specified as an input (Glacier Mass Balance File). Input files should be as 

follows: 

 

 Domain Mask File = the file generated in the Glacier Domain Mask step above 

 Glacier Mask File = the file generated in the Glacier Domain Mask step above 

 Glacier Bed Topo File = basin DEM from the Glacier Bed Topography step 

above 

 Glacier Surface Topo File = not required. I use the DEM that represents a thick 

layer of ice across the entire domain (DEM+1000m everywhere) as a 

placeholder. 

 Basin Mask File = watershed mask 

 Glacier Mass Balance File = mass balance file created from the previous model 

run (GLSTATIC) that was divided by the number of simulation years. 

 

Change the input file for the DHSVM. I recommend saving a new input file for the SPINUP  

model run. This will output the ice thickness file (h_spinup.bin). Surface topography of the 

watershed including the glaciers can be calculated from this file. 

 

Import h_spinup.bin into ArcMap using the steps outlined in the previous section. Visualize 

the simulated glacier extent at end of spinup period and compare with the observed extent. If 

the mass balance field does not accurately represent the forcings that control the glaciers’ 

current extent, the mass balance field may need to be iteratively altered so that the glaciers 

will grow to appropriately match the observed extent. For example, if the mass balance field 

was generated from recent meteorological forcing data that was much warmer than the 

historical time period, the mass balance field is likely too low to grow glaciers of size 

comparable to what is observed. 

 

Once satisfied with the simulated glacier extent from the spinup time period, use the raster 

calculator in ArcMap to add the ice thickness (h_spinup) to the DEM. This will serve as the 

calculated glacier surface topography (ice thickness + bed topography) as an input for the 

coupled model simulations (GLDYNAMIC). 

 

3. To run the dynamic coupled glacier-hydrology model, change the input file for the DHSVM 

and set the glacier mode to GLDYNAMIC. 

 

 Domain Mask File = the file generated in the Glacier Domain Mask step above 

 Glacier Mask File = the file generated in the Glacier Domain Mask step above 

 Glacier Bed Topo File = basin DEM from the Glacier Bed Topography step above 

 Glacier Surface Topo File = Use the ice thickness + DEM layer that was created in the 
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SPINUP. 

 Basin Mask File = watershed mask 

 Glacier Mass Balance File = not required. 

 

Calibration 

Calibrating the glaciers before calibrating the hydrology is recommended. 

 

Recommended glacier calibration procedure: 

1. Run the simulation for just glacier areas and SNOTEL locations under the GLSTATIC 

option to calibrate the model for accumulation and ablation processes. This is done in 

ArcMap by altering the domain mask by setting the parts of the watershed that you want to 

run (i.e. glacier extent and SNOTEL areas) to 1 and the other areas to 0. You can run this for 

the entire watershed, but the computational efficiency will improve if only the areas of 

interest are used in the domain. Since the model is set to the static glacier option, the 

glaciated cells are independent of each other (for the glacier component of the DHSVM) and 

the entire watershed mask is not needed. Compare mass balance model results to where 

observations are available. Ideally you would want to compare with accumulation on the 

glacier because glaciers are at higher elevations than SNOTEL sites, but you have to work 

with what you have. 

 

sensitive parameters: temperature lapse rate, precipitation lapse rate, maximum snow albedo, glacier 

albedo  

 

Note: make vegetation class at SNOTEL locations bare, as most of these locations are in clearings 

 

2. Now that you have an accurate simulation of mass balance processes, calculate mean annual 

mass balance across the entire domain with this calibration (running the model with 1000+ 

meters of ice everywhere) using the GLSTATIC option. The model will output a mass 

balance file, which needs to be divided by the number of years in the simulation. 

 

3. Use the mean annual mass balance field to force the spin-up (GLSPINUP option). Since the 

mass balance reflects current climate which is warmer, the glaciers will not likely grow to 

historical extent. 

 

4. Iteratively adjust the mass balance field to grow the glaciers to the historical extent. You can 

do this by adding or subtracting a small amount (e.g. 1 or 2 or 3) to the mass balance field 

using the raster calculator or by altering parameters within the DHSVM and rerunning the 

static glacier model to produce a new mass balance output. This will force the model to 

accumulate more ice, better reflecting historical glaciation. If the glacier is producing too 

much ice, iteratively decrease the mass balance field until satisfied with the glacier extent. 

 

5. After the glacier calibration is complete, the DHSVM can be calibrated to hydrology.  

 

 Calibration notes: 

 Using the static glaciers option (GLSTATIC), glaciers that have finite mass and cell to 

cell ice flow is not simulated. Over short timescales of 1-10 years this is a valid 

assumption depending of the watershed location, relative glacier cover, and drainage 

area. This will allow the user to calibrate watershed properties (soil, vegetation, 

temperature, precipitation lapse rates) and have some contribution of glacier melt 
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included. For this application, a surface topography file will need to be created that 

reflects ice mass with the glacier masked area (e.g., Surface Topography = 100m (or 

more) + Bed Topography in areas located within the glacier mask. 

 In snowmelt dominated basins, most of the hydrograph will be related to snowmelt. 

Using the NOGLACIER option, watershed calibration can also be conducted as long as it 

is recognized that in months where glaciers are expected to contribute the most, 

streamflow will be biased low. 

 Later calibration efforts to match glacier rates of recession and glacier mass balance 

observations will be conducted with the GLDYNAMIC run option. 

 

Calculating Contribution of Glacial Melt to Streamflow 

The easiest way to determine the contribution of glacial ice melt to streamflow is to run the calibrated 

and validated model using the NO_GLACIER mode and then run it again using the dynamic glacier 

mode. The melt contribution to streamflow is the difference between the streamflow outputs of the 

two model runs. 

 

Glacier Model Output 

 

gl_sn_cov.txt 

Reports snow and glacier extent (km
2
) and ice volume (m

3
) at monthly timesteps. 

 

gl_cov_glac6_7.txt 

Reports glacier area and volume for 2 individual glaciers denoted in the glacier mask file with 

integers 6 and 7. 

 

balance_glac6_7.txt 

Reports specific net balance at a monthly time-step for 2 individual glaciers denoted in the glacier 

mask file with integers 6 and 7. 

 

balance_sum.bin 

Grid of cumulative mass balance across the simulated domain. This can be used to calculate mean 

annual mass balance field for the SPINUP run. 

 

h_spinup.bin 

Grid of ice thickness at the end of the glacier ice spin-up run 

 

Additions to existing DHSVM output files 

Glacier ice water equivalent and glacier melt have been added to the Mass.Balance and Aggregated 

files. Maps of glacier ice water equivalent can be dumped (variable ID #705). IceRemoved is variable 

included in the calculation of mass balance to track ice mass that is removed from the simulation with 

NO_GLACIER option. 

 

Miscellaneous 

1. Estimated bed topography: the method suggested above, among others in the literature, 

require multiple inputs (e.g., thinning rates, distributed mass balance) and the applicability of 

these methods are limited by the resolution and accuracy of the DEM and size of the glaciers 
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being simulated. Experiments in areas where glacier masses are relatively thin with respect to 

the DEM resolution, suggest that using the DEM as bed topography does not yield 

significantly different results than using bed topography estimated using a more complex 

method.  

 

Comparing the effects of using estimated bed topography and a DEM as inputs for bed 

topography in the model spinup step in the Bow River Basin (Naz et al., 2014), demonstrated 

that using the estimated bed topography yielded 10% more glacier volume, and almost no 

difference in glacier area. The glaciers in the Bow River Basin were estimated to be up to 

over 300 m thick. 

 

Steady state glacier thicknesses from this spinup method may not be representative of the 

current/historical transient state of the glaciers. If the glaciers in the couple simulation do not initially 

recede but do lose mass (and the actual glaciers were observed to recede) it is likely that the glaciers 

are actually in a thinner transient state. To thin the glaciers to a transient state from the steady state 

condition one can run the model with current climate forcings, thinning the glaciers without changing 

their area. The amount of years required to do this is an iterative procedure and is validated when 

rates of recession are well simulated. 
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11.0 Appendix C. MACA Downscaling Methodology 

Researchers at the University of Idaho (UI) have made available a variety of 

downscaled gridded datasets for the western United States by employing the Multivariate 

Adaptive Constructed Analogs (MACA) method. The MACA statistical downscaling method 

utilizes the daily results from 20 different GCMs of the CMIP5 and users may select which 

downscaled GCM outputs they would like from the MACA webpage 

(maca.northwestknowledge.net). The MACA method is unique in that it incorporates a 

training dataset (the Livneh 2013 gridded dataset used in model calibration) to match spatial 

patterns in GCM output and remove historical biases. Due to the scarcity of meteorological 

stations prior 1950, only the Livneh data for years 1950-2011 are used as a training set for 

downscaling. The MACA method is a six step process (from Abatzoglou and Brown, 2012): 

 

1. Observational data and results from GCMs are interpolated to a common grid at 1 

degree lat/long resolution 

2. Using a 21-day, 31-year running mean, seasonal and annual trends are calculated 

at each grid point for both the observational data and GCMs and are removed 

3. The cumulative distribution function (CDF) for a 15-day window for all years of 

data is calculated at each grid point for both the GCM and observational data. The 

CDF of the historical GCM and future GCM is mapped to the CDF of the 

observational data. Quantile differences between the historical and future GCM 

data are preserved. 

4. By identifying days in the observational record that have similar spatial patterns 

to the target GCM day, a best fit approach is applied. The best 100 patterns are 
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selected based on the lowest root-mean-square error to the target pattern. A linear 

model is constructed based on coefficients for each spatial pattern. These same 

coefficients are then applied to the fine-scale (1/16 degree lat/long) observational 

data to create the downscaled GCM grid. 

5. Adjustments removed from step two are reintroduced. This ensures consistency 

with GCM outputs. 

6. A final bias correction to ensure compatibility with the observational dataset is 

performed. 

 

The downscaled datasets are available publically from the UI MACA website and are 

downloadable in a network common data form (.nc file) or as text files which can be used in 

the DHSVM once disaggregated into 3-hr timesteps and converted into a binary form. 

Disaggregation was carried out with the VIC model (Liang et al., 1994). To maintain 

consistency with the calibrated model, all bias corrections and lapse rate changes that were 

applied to the historical Livneh meteorological grid were applied to the MACA downscaled 

GCM grids. 
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12.0 Appendix D. Collaboration and Deliverables to Funding Agencies 

This project was part of a larger scope of work that was overseen by the Nooksack 

Indian Tribe to assess the water resources of the Nooksack River. The scope of the project 

aimed to evaluate the effects of climate change on hydrology, glacier recession, and fish 

habitat as well as provide methods to help reduce potential impacts on the salmonid species 

present in the Nooksack River. The predicted impact of changes in late summer streamflows 

on fish habitat will be evaluated at key Assessment Sites located throughout the upper 

Nooksack River and various tributaries. My model outputs were generated at WRIA 1 

Assessment Sites in the South, Middle and North Forks (as listed in WRIA 1 Data Integration 

of Hydrology, Fish Habitat and Hydraulics models, Bandaragoda et al., 2014) to update 

existing hydrology-fish habitat relationships based on hydrologic modeling done in the 

Lower Nooksack Water Budget (Bandaragoda et al., 2012). 
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